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About This Guide
Introduction
This guide provides information about using the MC3000 mobile computers and accessories.

Documentation Set

The documentation set for the MC3000 is divided into guides that provide information for specific user needs.

• Microsoft Applications for Windows Mobile and CE 5.0 User Guide - describes how to use Microsoft 
developed applications.

• Microsoft Applications for Windows Mobile 6 User Guide - describes how to use Microsoft Windows 
Mobile 6 developed applications.

• Application Guide for Motorola Enterprise Mobility Devices - describes how to use Motorola Enterprise 
Mobility developed applications.

• MC3000 User Guide - describes how to use the MC3000 mobile computer.

• MC3000 Integrator Guide - describes how to set up the MC3000 mobile computer and the accessories.

• EMDK Help File - provides API information for writing applications.

NOTE     Screens and windows pictured in this guide are samples and may differ from actual screens.
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Configurations
This guide covers the following configurations:

Software Versions

This guide covers various software configurations and references are made to operating system or software 
versions for:

• Adaptation Kit Update (AKU) version

• OEM version

• BTExplorer version

• Fusion version.

AKU Version for Windows Mobile 6.1 Devices

To determine the Adaptation Kit Update (AKU) version on a Windows Mobile 6.1 device:

Tap Start > Settings > System tab > About icon > Version tab.

Configuration Radios Display Memory Data 
Capture

Operating
System Keypads

MC3000R None Color or 
monochrome

32 MB RAM/
64 MB Flash or 
64 MB RAM/
64 MB Flash

1D laser 
scanner in 
rotating 
turret

Windows 
CE 5.0 Core or 
Professional

28, 38 or 48 
key

MC3090G WLAN: 802.11a/b/g
WPAN: Bluetooth

Color or 
monochrome

32 MB RAM/
64 MB Flash or 
64 MB RAM/
64 MB Flash

1D laser 
scanner or 
2D imager

Windows 
CE 5.0 Core or 
Professional

28, 38 or 48 
key

MC3090S WLAN: 802.11a/b/g
WPAN: Bluetooth

Color 64 MB RAM/
64 MB Flash or 
128 MB RAM/
64 MB Flash or 
128 MB 
RAM/64 MB 
Flash + 1GB 
Flash storage

1D laser 
scanner, 2D 
imager or 
DPM imager

Windows 
CE 5.0 
Professional or 
Windows 
Mobile 6.1 
Classic

28, 38, 48 key 
or 20 key 
Mechanical

MC3090R WLAN: 802.11a/b/g
WPAN: Bluetooth

Color or 
monochrome

32 MB RAM/
64 MB Flash or 
128 MB 
RAM/64 MB 
Flash + 1GB 
Flash storage

1D laser 
scanner in 
rotating 
turret

Windows 
CE 5.0 Core or 
Professional or 
Windows 
Mobile 6.1 
Classic

28, 38, 48 key 
or 20 key 
Mechanical
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The second line lists the operating system version and the build number. The last part of the build number 
represents the AKU number. For example, Build 119581.1.1.1 indicates that the device is running AKU version 
1.1.1.

OEM Version on Windows Mobile 6.1 Devices

To determine the OEM software version on a Windows Mobile 6.1 device:

Tap Start > Settings > System tab > System Information icon > System tab.

OEM Version on Windows CE 5.0 Devices

To determine the OEM software version on a Windows CE 5.0 device:

Tap Start > Settings > Control Panel > System Info icon > System tab.
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BTExplorer Software

To determine the BTExplorer software version on a Windows Mobile 6.1 or Windows CE 5.0 device:

Tap BTExplorer icon > Show BTExplorer> File > About.

Fusion Software

To determine the Fusion software version on a Windows Mobile 6.1 or Windows CE 5.0 device:

Tap Wireless Strength icon > Wireless Status > Versions.
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Chapter Descriptions
Topics covered in this guide are as follows:

• Chapter 1, Getting Started, describes the mobile computer’s physical characteristics, how to install and 
charge the batteries, remove and replace the Strap/Door assembly and how to start the mobile computer for 
the first time.

• Chapter 2, Operating the MC3000, provides basic instructions for using the mobile computer and navigating 
the mobile computer software.

• Chapter 3, Using Bluetooth, explains how to perform Bluetooth functionality on the mobile computer.

• Chapter 4, Accessories, describes the accessories available for the mobile computer and how to use the 
accessories to charge the mobile computer.

• Chapter 5, Maintenance and Troubleshooting, includes instructions on cleaning and storing the mobile 
computer, and provides troubleshooting solutions for potential problems during mobile computer operation.

• Appendix A, Technical Specifications, includes a table listing the technical specifications for the mobile 
computer.

• Appendix B, Keypad Functions/Special Characters, contains special character generation tables.

• Appendix C, Regulatory, contains the accessory power supply regulatory compliance statements.

Notational Conventions
The following conventions are used in this document:

• The term “mobile computer” refers to the Motorola MC3000.

• Italics are used to highlight the following:
• Chapters and sections in this and related documents
• Dialog box, window and screen names
• Drop-down list and list box names
• Check box and radio button names
• Icons on a screen.

• Bold text is used to highlight the following:
• Key names on a keypad
• Button names on a screen.

• Bullets (•) indicate:
• Action items
• Lists of alternatives
• Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.
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Related Documents and Software
The following items provide more information about the MC3000 mobile computers.

• MC3000 Series Quick Start Guide, p/n 72-68902-xx

• MC3090G Quick Start Guide, p/n 72-71347-xx

• MC3000 Regulatory Guide for Windows Mobile 6, p/n 72-114046-xx

• MC3000 Licensing, Patent and Regulatory Information, p/n 72-68903-xx

• MC3000 Integrator Guide, p/n 72E-68900-xx

• Application Guide for Motorola Enterprise Mobility Devices, p/n 72E-68901-xx

• Microsoft® Applications for Mobile and CE 5.0 User Guide, p/n 72E-78456-xx

• Microsoft® Applications for Mobile 6 User Guide, p/n 72E-108299-xx

• Enterprise Mobility Developer Kit (EMDK) Help File, p/n 72E-38880-03

• Windows CE Platform SDK for MC3000c50, available at: http://www.motorola.com/enterprisemobility/support

• Enterprise Mobility Developer Kit for C (EMDK for C), available at: 
http://www.motorola.com/enterprisemobility/support

• Device Configuration Package for MC3000 (DCP for MC3000), available at: 
http://www.motorola.com/enterprisemobility/support

• ActiveSync software, available at: http://www.microsoft.com.

For the latest version of this guide and all guides, go to: http://www.motorola.com/enterprisemobility/manuals.

Service Information
If you have a problem with your equipment, contact Motorola Enterprise Mobility support for your region. Contact 
information is available at: http://www.motorola.com/enterprisemobility/contactsupport.

When contacting Enterprise Mobility support, please have the following information available:

• Serial number of the unit

• Model number or product name

• Software type and version number

Motorola responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Motorola Enterprise Mobility Support, you may need to return your equipment 
for servicing and will be given specific directions. Motorola is not responsible for any damages incurred during 
shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the 
warranty.

If you purchased your Enterprise Mobility business product from a Motorola business partner, contact that business 
partner for support.

http://www.motorola.com/enterprisemobility/contactsupport
http://www.motorola.com/enterprisemobility/support
http://support.symbol.com
http://www.microsoft.com
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support


Chapter 1 Getting Started
Introduction
This chapter describes the mobile computer physical characteristics, how to install and charge the batteries, how to 
remove and replace the Strap/Door Assembly and how to start the mobile computer for the first time.

Unpacking the Mobile Computer
Carefully remove all protective material from around the mobile computer and save the shipping container for later 
storage and shipping. Verify that the equipment listed below is included:

• MC3000 mobile computer

• Strap/Door Assembly, attached to the mobile computer

• Stylus

• Regulatory Guide

• Quick Start Guide.

Depending on the configuration ordered, the mobile computer shipping container or additional shipping container 
may include:

• Standard battery (lithium-polymer)

• Extended life battery (lithium-ion)

• Cable(s)

• Power supply

• Cradles.

Inspect the equipment for damage. If any equipment is missing or damaged, contact the Motorola Enterprise 
Mobility Support immediately. See Service Information on page xvi for contact information.
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Accessories
Table 1-1 lists the MC3000 accessories.

Table 1-1    MC3000 Accessories

Accessory Description

Single Slot Serial/USB Cradle Charges the mobile computer main battery and a spare battery, and 
synchronizes the mobile computer with a host computer through either a serial 
or USB connection.

Four Slot Charge Only Cradle Charges up to four mobile computers. 

Four Slot Ethernet Cradle Charges up to four mobile computers and provides Ethernet communications. 

Four Slot Spare Battery Charger Charges up to four mobile computer spare batteries.

Power Supply Country specific and accessory specific, power supply.

USB Client Charge Cable Provides USB client communication capabilities and charges the mobile 
computer.

RS232 Charge Cable Provides RS232 communication capabilities and charges the mobile 
computer.

O’Neil Printer Cable Provides printer specific communication capabilities (provided by O’Neil).

Zebra Printer Cable Provides printer specific communication capabilities (provided by Zebra).

Monarch Printer Cable Provides printer specific communication capabilities (provided by Monarch).

Single Slot Cradle RS232 Cable Provides serial host communication capabilities and charges the mobile 
computer.

Single Slot Cradle USB Cable Provides USB communication capabilities and charges the mobile computer.

MC3000 Universal Battery Charger 
Adapter (UBC)

Adapts the UBC for use with MC3000 batteries.

Stylus Performs pen and mouse functions.

Plastic Holster Provides a clip on holder for the mobile computer.

Fabric Holster Provides a soft, clip on holder and a shoulder strap for the mobile computer.

Enterprise Mobility Developer Kit 
for C (EMDK for C)

A development tool used to create native C and C++ applications for all 
Motorola mobile computers running the Microsoft Windows CE operating 
system. Available at: http://www.motorola.com/enterprisemobility/support.

Device Configuration Package 
(DCP) for MC3000

A development tool used to create and download hex images that represent 
flash partitions to the mobile computer. Available at: 
http://www.motorola.com/enterprisemobility/support.

http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
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Parts
There are three versions of the MC3000 mobile computers, the MC3000 1D/2D Imager (MC3000S or MC3090S), 
the MC3000 Laser with Rotating Scan Turret (MC3000R or MC3090R) and the MC3090 Gun (MC3090G). For 
more information on the Rotating Scan Turret, see Figure 1-3 on page 1-4.

Figure 1-1    MC3000 Imager and MC3000 Laser Mobile Computers (Front View)

Keypad

Indicator LED Bar

Display

Scan LED Indicator 
(red/green)

Power

Scan Buttons

MC3000R MC3000S 

Rotating Scan 
Turret

Beeper or 
Receiver 
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Microphone
(optional)

Scan LED
Indicators

(red/green)

Charge LED
Indicator
(amber)



1 - 4 MC3000 User Guide
Figure 1-2    MC3000 Imager and MC3000 Laser Mobile Computers (Back View)

Rotating Scan Turret

The MC3000R mobile computer features a Rotating Scan Turret with three position stops. This feature offers 
greater scanning flexibility.

Figure 1-3    Rotating Scan Turret

Strap/Door
Assembly

Scan Window

Stylus

MC3000S MC3000R 
Latches

Strap/Door 
Assembly 
Screws

Stylus 
Holder

Headset Jack
(optional)

Headset Jack 
(optional)Scan Window

Position Stop

Position Stop

Position Stop
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Figure 1-4    MC3090G Mobile Computer

Mobile Computer Startup
To start using the mobile computer:

• Install the main battery. 

• Charge the main battery and the backup battery.

• Start the mobile computer.

Install Main Battery

If the main battery is charged, the mobile computer can be used immediately. If the main battery is not charged, 
see Battery Charging on page 1-7. To remove the main battery, see Main Battery Removal on page 1-11.

To install the main battery:

1. Rotate the latches to the open position.

2. Pull on the strap to lift the Strap/Door Assembly off, bottom first.

Keypad

Indicator LED Bar
Display

Power

Scan Button

Beeper

Trigger

Scan LED 
Indicators 

(red/green)

Charge LED 
Indicator 
(amber)

Scan LED
Indicator

(red/green)

CAUTION Do not lift up on the latches when removing the Strap/Door Assembly. Lift up on the Hand Strap only. 



1 - 6 MC3000 User Guide
3. Insert the battery into the slot, bottom first and press the battery gently into the slot. The battery clip locks the 
battery into place.

4. With the latches in the open position, replace the Strap/Door Assembly, top first and press to close.

5. Rotate the latches (to the lock position) to lock the Strap/Door Assembly in place.

Figure 1-5    Main Battery Installation (MC3000S/R)

CAUTION On the MC3090G battery, do not remove the battery pull tab. The pull tab is for enabling easy battery 
removal from the device.

Battery Clip

Strap/Door
Assembly

Battery

Battery Slot

Hand StrapLatches



Getting Started 1 - 7
Figure 1-6    Main Battery Installation (MC3090G)

Battery Charging 

Use the mobile computer cradles, cables and spare battery chargers to charge the mobile computer main battery.

The main battery can be charged before insertion into the mobile computer or after it is installed. There are two 
main batteries for the MC3000, the Standard Battery and the Extended Life Battery. Either battery can be used, but 
the Extended Life Battery requires a different Strap/Door Assembly. Use one of the spare battery chargers to 
charge the main battery (out of the mobile computer) or one of the cradles to charge the main battery while it is 
installed in the mobile computer. 

Before using the mobile computer for the first time, fully charge the main battery until the amber Charge LED 
Indicator remains lit (see Table 1-2 on page 1-8 for charge status indications). The Standard Battery fully charges in 
less than four hours and the Extended Life Battery fully charges in less than six hours.

The mobile computer is equipped with a memory backup battery which automatically charges from the main 
battery whether or not the mobile computer is operating or is in suspend mode. The memory backup battery retains 
data in memory for at least 30 minutes when the mobile computer’s main battery is removed or fully discharged. 
When the mobile computer is used for the first time or after the memory backup battery has fully discharged, the 
memory backup battery requires approximately 15 hours to fully charge. Do not remove the main battery from the 
mobile computer for 15 hours to ensure that the memory backup battery fully charges. If the main battery is 

5

2

0.5 in.
(12.7 mm)

31

Strap/Door 
Assembly

Battery

Hand StrapLatches

Strap/Door 
Assembly

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.
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removed from the mobile computer or the main battery is fully discharged, the memory backup battery completely 
discharges in several hours.

When the main battery reaches a very low battery state, the combination of main battery and backup battery 
retains data in memory for at least 72 hours.

Batteries must be charged within the 32° to 104° F (0° to +40° C) ambient temperature range.

The following accessories can be used to charge batteries:

• Cradles (and a power supply): 
• Single Slot Serial/USB Cradle
• Four Slot Cradles.

• Cables (and a power supply): 
• USB Client Charge Cable
• Serial (RS232) Charge Cable.

• Spare Battery Chargers (and a power supply): 
• Single Slot Serial/USB Cradle
• Four Slot Spare Battery Charger 
• Universal Battery Charger (UBC) Adapter.

To charge the mobile computer using the cradles:

1. Insert the mobile computer into a cradle. See Chapter 4, Accessories for accessory setup.

2. The mobile computer starts to charge automatically. The amber Charge LED Indicator indicates the charge 
status. See Table 1-2 on page 1-8 for charging indications.

To charge the mobile computer using the cables:

1. Connect the MC3000 Communication/Charge Cable to the appropriate power source and connect to the 
mobile computer. See Chapter 4, Accessories for accessory setup.

2. The mobile computer starts to charge automatically. The amber Charge LED Indicator indicates the charge 
status. See Table 1-2 for charging indications.

NOTE Do not remove the main battery within the first 15 hours of use. If the main battery is removed before the 
backup battery is fully charged, data may be lost.

Table 1-2    Mobile Computer LED Charge Indicators  

LED Indication

Off Mobile computer not placed correctly in the cradle; charge cable not connected correctly; 
charger is not powered.

Fast Blinking Amber Error in charging; check placement of the mobile computer.

Slow Blinking Amber Mobile computer is charging.

Solid Amber Charging complete.
Note: When the battery is initially inserted in the mobile computer, the amber LED 
flashes once if the battery power is low or the battery is not fully inserted.
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Spare Battery Charging
There are three accessories that can be used to charge a spare battery: 

• Single Slot Serial/USB Cradle

• Four Slot Spare Battery Charger

• UBC Adapter.

To charge a spare battery:

1. Connect the charging accessory to the appropriate power source. See Chapter 4, Accessories for setup 
instructions.

2. Insert the spare battery into the spare battery charging slot and gently press down on the battery to ensure 
proper contact.

The battery starts to charge automatically. The amber charge LED Indicator lights to indicate the charge status. 
See Chapter 4, Accessories for charging indications. The Standard Battery usually fully charges in less than four 
hours and the Extended Life Battery usually fully charges in less than six hours.

Stylus
Use the stylus for selecting items and entering information on the screen. The stylus functions as a pen and a 
mouse. Tap the touch screen once with the stylus to select options and open menu items.

To remove the stylus, slide the stylus out of the stylus holder. To store the stylus, push the stylus back into the 
stylus holder. 

Starting the Mobile Computer
On 28, 38 and 48-key keypad configurations, press the Power button to turn on the mobile computer. On 20-key 
keypad configurations, simultaneously press the Fn and MENU buttons to turn on the mobile computer. If the 
mobile computer does not power on, perform a cold boot. See Resetting the Mobile Computer on page 2-34.

When the mobile computer is powered on for the first time, it initializes. The Splash screen appears for a short 
period of time, followed by the Calibration screen.
 

Figure 1-7    Splash Screen

OR



1 - 10 MC3000 User Guide
On Windows CE 5.0 configurations, after the calibration procedure is performed the factory settings launch the 
Demo window. Application specific shells may provide application specific windows instead of the Demo window. 
These screens also appear when a cold boot is performed.

If the mobile computer does not power on, see Resetting the Mobile Computer on page 2-34.

Calibration Screen

Use the Calibration screen to align the touch screen:

1. Remove the stylus from the stylus holder.

2. Carefully press and briefly hold the stylus tip on the center of the Calibration screen target. Repeat the 
procedure as the target moves and stops at different locations on the screen. This enters the new calibration 
settings.

 

Figure 1-8    Calibration Screen

3. Once all of the new calibration settings are input, tap the screen or press the ENTER button to save the new 
calibration settings. Press ESC to discard the new calibration settings.

Demo Window (Windows CE Only)
The Demo window is the factory default menu. On initial power up (or on a warm or cold boot) the Demo window 
appears. These sample/demo applications are intended to be used by application developers as application 
development examples. These applications were not developed to support end users. Refer to the Application 
Guide for Motorola Enterprise Mobility Devices for information about the Demo window applications.

Figure 1-9    Demo Window

Calibration Screen Confirm Calibration 
Resave Screen
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Waking the Mobile Computer
The wakeup condition settings are used to define what actions wake up the mobile computer. The settings are 
configurable so they are subject to change/update. For more information see, Waking the Mobile Computer on 
page 2-35.

Main Battery Removal
Before removing the main battery, turn off the mobile computer.

To remove the main battery:

1. Rotate the latches to the open position.

2. Lift the Hand Strap to lift the Strap/Door Assembly off, bottom first.

3. Release battery:

a. On the MC3000S/R, release the battery clip (at the top of the battery) and lift the battery out top first.

b. On the MC3090G, pull the battery pull tab to unclip the battery and lift the battery out top first. If the battery 
does not have a pull tab, use the stylus to unclip the battery and then lift the battery.

Figure 1-10    Main Battery Removal (MC3000S/R)

CAUTION Do not lift up on the latches when removing the Strap/Door Assembly. Lift up on the Hand Strap only.

CAUTION On the MC3090G battery, do not remove the battery pull tab. The pull tab is for enabling easy battery 
removal from the device.

Battery Clip

Latches Strap/Door
Assembly

Battery

Hand Strap
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Figure 1-11    Main Battery Removal (MC3090G)

Strap/Door Assembly Removal and Replacement (MC3000S/R)
The Strap/Door Assembly consists of a hand strap and the battery door. There are two versions of this assembly, 
one for the Standard Battery and one for the Extended Life Battery. Before removing the Strap/Door Assembly, 
press the red Power button to turn off the screen and set the mobile computer to suspend mode.

To remove the Strap/Door Assembly:

1. Rotate the latches to the open position.

2. Lift the Hand Strap to lift the Strap/Door Assembly off, bottom first.

3. Use a #00 Phillips screwdriver to remove the screws.

4. Lift the mounting clip.

5. Slide the mounting clip out of the strap loop.

Reverse the procedure to replace the Strap/Door Assembly.

2

0.5 in.
(12.7 mm)

31

44

Strap/Door 
Assembly

Latches

Battery Pull Tab

Battery with Pull Tab Battery without Pull Tab

NOTE The SD card holder is located under the battery. To install the SD card, see Secure Device Card (Windows CE 
5.0 Only) on page 4-12.

CAUTION Do not lift up on the latches when removing the Strap/Door Assembly. Lift up on the Hand Strap only.
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Figure 1-12    Strap/Door Removal and Replacement (MC3000S/R)

Strap/Door Assembly Removal and Replacement (MC3090G)
The Strap/Door Assembly consists of a hand strap and the battery door. Before removing the Strap/Door Assembly, 
press the red Power button to turn off the screen and set the mobile computer to suspend mode.

To remove the Strap/Door Assembly:

1. Slip the button through the loop.

2. Remove loop section from handle.

3. Rotate the latches to the open position.

4. Lift the Hand Strap to lift the Strap/Door Assembly off, bottom first.

Reverse the procedure to replace the Strap/Door Assembly.

Strap/Door
Assembly

Latches

Screws

#00 Phillips
Screwdriver

Mounting 
ClipStrap Loop

Mounting 
Clip

Hand Strap

CAUTION Do not lift up on the latches when removing the Strap/Door Assembly. Lift up on the Hand Strap only.
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Figure 1-13    Strap/Door Removal and Replacement (MC3090G)

Turning Off the Radios

On Device with Windows CE 5.0 (OEM Version 01.15 or lower)

WLAN Radio

To turn off the WLAN radio:

1. Tap Start > Settings > Control Panel > Power icon > PwrDevices tab.

2. In the text box, scroll down until WLP1: displays.

3. Select WLP1:. WLP1: displays in the text box at the top of the window.

4. In the drop-down list box, select D4.

5. Tap Set.

To turn on the radio:

1. Tap Start > Settings > Control Panel > Power icon > PwrDevices tab.

2. In the text box, scroll down until WLP1: displays.

0.5 in.
(12.7 mm)

Strap/Door
AssemblyLatches

Button

Loop

NOTE To determine the operating system OEM version, see Configurations on page xii.
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3. Select WLP1:. WLP1: displays in the text box at the top of the window.

4. In the drop-down list box, select D0.

5. Tap Set.

Bluetooth Radio

To turn off the Bluetooth radio, tap Bluetooth icon in the task tray and select Disable Bluetooth.

Figure 1-14    Bluetooth Icon

To turn on the Bluetooth radio, tap Bluetooth icon in the task tray and select Enable Bluetooth.

On Device with Windows CE 5.0 (OEM Version 01.16 or higher)

WLAN Radio

To turn off the WLAN radio tap the Wireless Connection Status icon on the task tray and select Disable Radio. A red 
X appears across the icon indicating that the radio is disabled (off).

Figure 1-15    Wireless Connection Status Icon

To turn the radio back on, tap the Wireless Connection Status icon on the task tray and select Enable Radio. The red 
X disappears from the icon indicating that the radio is enabled (on).

Bluetooth Radio

To turn off the Bluetooth radio, tap Bluetooth icon in the task tray and select Disable Bluetooth.

Figure 1-16    Bluetooth Icon

To turn on the Bluetooth radio, tap Bluetooth icon in the task tray and select Enable Bluetooth.

On Devices with Windows Mobile 6.1

Windows Mobile 6.1 devices include Wireless Manager, which provides a simple method of enabling, disabling, and 
configuring all the device’s wireless capabilities in one place.

To open Wireless Manager, tap the Connectivity icon.

Bluetooth Icon

NOTE To determine the operating system OEM version, see Configurations on page xii.

Wireless Connection Status Icon

Bluetooth Icon
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Figure 1-17    Opening Wireless Manager

Select Wireless Manager.

Figure 1-18    Wireless Manager Window

To enable or disable a wireless connection, tap its blue bar.

To enable or disable all wireless connections, tap and hold the All bar.

To configure settings for a connection, tap Menu.

Figure 1-19    Wireless Manager Menu



Chapter 2 Operating the MC3000
Introduction
This chapter provides basic instructions for using the mobile computer and navigating the mobile computer 
software.

Power Button
Press the red Power button to toggle the mobile computer between suspend and resume. When the screen is off 
the mobile computer is in suspend mode and when the screen is on the mobile computer is on.

Keypads
The mobile computer is available with the following keypad configurations:

• 20-key mechanical keypad

• 28-key keypad

• 38-key keypad 

• 48-key keypad.

NOTE For information about using the soft keyboard input panel. For more information, see Entering Information 
Using the Keyboard Input Panel on page 2-25.
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Keypad Special Functions
The keypad special functions are color coded on the keypads. For example, on the 38-key keypad, the display 
contrast icon is blue indicating that the blue function key must be selected first along with the F6 key, to increase 
the display contrast.

Table 2-1    Keypad Special Functions

Icon 28-Key 
Keystrokes

38-Key 
Keystrokes

48-Key 
Keystrokes Special Function

Blue function key 
and period.

Blue function 
key and F6

Blue function 
key and N

Increases display contrast setting, darkens the 
display (on monochrome units only).

Blue function key 
and BKSP.

Blue function 
key and F9

Blue function 
key and S

Decreases display contrast setting, lightens the 
display (on monochrome units only).

Blue function key 
and the up arrow.

Blue function 
key and F7

Blue function 
key and R

Increases scan decode beeper volume.

Blue function key 
and down arrow.

Blue function 
key and F10

Blue function 
key and W

Decreases scan decode beeper volume.

NOTE Mobile computers with color screens do not have contrast settings.
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20-Key Mechanical Keypad

The 20-key mechanical keypad contains a Power button, application keys, scroll keys and function keys. The 
keypad is color-coded to indicate the alternate function key (blue) values. Note, that keypad functions can be 
changed by an application so the mobile computer keypad may not function as described. See Table 2-4 on page 
2-8 for key and button descriptions.

Figure 2-1    20-Key Mechanical Keypad

Table 2-2    20-Key Mechanical Keypad Descriptions

Key Description

Menu Produces the lower case alphabetic f.
Turns the mobile computer on and off when simultaneously pressed with the down arrow 
key. See Resetting the Mobile Computer on page 2-34 for warm and cold boot procedures.

Fn Press and release the blue FUNC key to activate the keypad alternate functions. The  
icon appears on the taskbar. Press and release the blue FUNC key again to return to the 
default keypad functions.

Arrow keys Moves up and down from one item to another. 
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Numeric keys Produces 0 - 9 numeric characters.

period Produces a (.) period.

C Produces a backspace.

ESC Exits the current operation.

ENTER Executes a selected item or function.
Produces a TAB character when pressed after the Fn key.

Table 2-2    20-Key Mechanical Keypad Descriptions (Continued)

Key Description
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28-Key Keypad

The 28-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values and the alternate ALPHA key (orange) values. Note 
that keypad functions can be changed by an application so the mobile computer keypad may not function as 
described. See Table 2-3 on page 2-5 for key and button descriptions and Table 2-1 on page 2-2 for the keypad 
special functions.

Figure 2-2    28-Key Keypad

Table 2-3    28-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Programmable application function key by default. 

Red Circle Programmable application function key by default. 

Scan (yellow) Used in scanning applications, press to scan a bar code. This key has the same 
function as activating the side mounted scan buttons.

Scroll Up and Down Moves up and down from one item to another. Increases/decreases specified 
values.
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Scroll Left and Right Moves left and right from one item to another. Increases/decreases specified values.
Produces a TAB when the blue FUNC key is activated and the right arrow key is 
pressed.

ESC Produces the ESC function by default. 

CTRL Press and release the CTRL key to activate the keypad alternate CTRL functions. 
The  icon appears on the taskbar on WinCE devices or the  icon appears at 
the bottom of the screen on Windows Mobile 6.1 devices. Press and release the 
CTRL key again to return to the default keypad functions.

Numeric/Alpha/Special 
Function

Numeric, alpha or special function keys. Numeric by default.
Produces a special function when the blue FUNC key is activated.
Produces alpha values when the orange ALPHA key is activated. 
In Alpha state, produces the lower case alphabetic characters on the key. Each key 
press produces the next alphabetic character in sequence. For example, press and 
release the ALPHA key and then press the 4 key once to produce the letter ‘g’; press 
and release the ALPHA key and then press the 4 key three times to produce the 
letter ‘i’.
When the SHIFT key is pressed in Alpha state, the upper case alphabetic characters 
on the key are produced. For example, press and release the ALPHA key, press and 
hold the SHIFT key and then press the 4 key once to produce the letter ‘G’; press 
and release the ALPHA key, press and hold the SHIFT key and then press the 4 key 
three times to produce the letter ‘I’.

Period/Decimal Point Produces a period for alpha entries and a decimal point for numeric entries by 
default.
Produces the F10 function when the blue FUNC key is activated.

Enter Executes a selected item or function.

BKSP BKSP, backspace function by default.

SPACE SPACE, space function by default.

Shift Press and release the SHIFT key to activate the keypad alternate SHIFT functions. 
The  icon appears on the taskbar on WinCE devices and the  icon appears at 
the bottom of the screen on Windows Mobile 6.1 devices. Press and release the 
SHIFT key again to return to the default keypad functions.

Table 2-3    28-Key Descriptions (Continued)

Key Description
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ALPHA (orange) Press the orange ALPHA key to access the alternate ALPHA characters (shown on 
the keypad in orange). The  icon appears on the taskbar on WinCE devices and 
the  icon appears at the bottom of the screen on Windows Mobile 6.1 devices. 
Press and release the orange ALPHA key again to return to the default keypad 
functions.

FUNC (blue) Press and release the blue FUNC key to activate the keypad alternate functions 
(shown on the keypad in blue). The  icon appears on the taskbar on WinCE 
devices or the  icon appears at the bottom of the screen on Windows Mobile 6.1 
devices. Press and release the blue FUNC key again to return to the default keypad 
functions.

Display backlight
Toggles the display backlight on and off.

Table 2-3    28-Key Descriptions (Continued)

Key Description
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38-Key Keypad

The 38-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values. Note that keypad functions can be changed by an 
application so the mobile computer keypad may not function as described. See Table 2-4 on page 2-8 for key and 
button descriptions and Table 2-1 on page 2-2 for the keypad special functions. 

Figure 2-3    38-Key Keypad

Table 2-4    38-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Programmable application function key by default.

Red Circle Programmable application function key. 
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Scan (yellow) Used in scanning applications, press to scan a bar code.

Scroll Left and Right Moves left and right from one item to another by default. 
Produces a TAB when the blue FUNC key is activated and the right arrow key is 
pressed.

Scroll Up and Down Moves up and down from one item to another by default. 

ALPHA (orange) Press the orange ALPHA key to access the alternate ALPHA characters (shown on the 
keypad in orange). The  icon appears on the taskbar on WinCE devices and the  
icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and 
release the orange ALPHA key again to return to the default keypad functions.

CTRL Press and release the CTRL key to activate the keypad alternate CTRL functions. The 
 icon appears on the taskbar on WinCE devices or the  icon appears at the 

bottom of the screen on Windows Mobile 6.1 devices. Press and release the CTRL key 
again to return to the default keypad functions.

CLEAR Clears inputs.

FUNC (blue) Press and release the blue FUNC key to activate the keypad alternate functions (shown 
on the keypad in blue). The  icon appears on the taskbar on WinCE devices or the 

 icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and 
release the blue FUNC key again to return to the default keypad functions.

Numeric/Alpha/Special 
Function

Press for the default numeric value. 
Produces alpha values when the orange ALPHA key is activated. 

BKSP/SPACE BKSP, backspace function by default.
Produces the SPACE function when the orange ALPHA key is activated.

SHIFT Press and release the SHIFT key to activate the keypad alternate SHIFT functions. The 
 icon appears on the taskbar on WinCE devices and the  icon appears at the 

bottom of the screen on Windows Mobile 6.1 devices. Press and release the SHIFT key 
again to return to the default keypad functions.

Enter Executes a selected item or function.

Table 2-4    38-Key Descriptions (Continued)

Key Description

. . .
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Period/Decimal Point Produces a period for alpha entries and a decimal point for numeric entries. 
Produces alpha values when the orange ALPHA key is activated. 

Comma Produces a comma by default. 
Produces alpha values when the orange ALPHA key is activated. 

Special Function/Alpha Special function by default or when the blue FUNC key is activated. 
Produces alpha values when the orange ALPHA key is activated. 

Display backlight Toggles the display backlight on and off.

Table 2-4    38-Key Descriptions (Continued)

Key Description

. . .
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48-Key Keypad

The 48-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values. Note, that keypad functions can be changed by an 
application so the mobile computer keypad may not function as described. See Table 2-4 on page 2-8 for key and 
button descriptions and Table 2-1 on page 2-2 for the keypad special functions. 

Figure 2-4    48-Key Keypad

Table 2-5    48-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Unassigned application function key by default.

Red Circle Unassigned application function key.

Scan (yellow) Scan key, used for scanning applications.

Orange Press the orange key to access the alternate navigation and selection functions. The  
icon appears on the taskbar on WinCE devices and the  icon appears at the bottom of 
the screen on Windows Mobile 6.1 devices. Press and release the orange key again to 
return to the default keypad functions.



2 - 12 MC3000 User Guide
Numeric/Scroll/Select Numeric, scroll, select keys. Numeric by default.
With the orange key activated, the 2, 4, 6, and 8 keys produce scroll functions and the 5 
key produces a select function. With the FUNC key activated, 7 produces the ESC function 
and 9 produces the TAB function.

Shift Press and release the SHIFT key to activate the keypad alternate SHIFT functions. The 
 icon appears on the taskbar on WinCE devices and the  icon appears at the bottom 

of the screen on Windows Mobile 6.1 device. Press and release the SHIFT key again to 
return to the default keypad functions.

Enter Executes a selected item or function.

BKSP/SPACE BKSP, backspace function by default.
Produces the SPACE function when the blue FUNC key is activated.

Period/Decimal Point Produces a period for alpha entries and a decimal point for numeric entries.

Control Press and release the CTRL key to activate the keypad alternate CTRL functions. The  
icon appears on the taskbar on WinCE devices or the  icon appears at the bottom of 
the screen on Windows Mobile 6.1 devices. Press and release the CTRL key again to 
return to the default keypad functions.
Press and release the blue FUNC key and then the CTRL key to activate the ALT 
functions. The  icon appears on the taskbar on WinCE devices or the  icon appears 
at the bottom of the screen on Windows Mobile 6.1 devices. Press and release the CTRL 
key two times to return to the default keypad functions.

Alpha/Special 
Function

Alpha by default. 
Special function by default when the blue FUNC key is activated.

FUNC (blue) Press and release the blue FUNC function key to activate the keypad alternate functions 
(shown on the keypad in blue). The  icon appears on the taskbar on WinCE devices or 
the  icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press 
and release the blue FUNC function key again to return to the default keypad functions.

Display Backlight Toggles the display backlight on and off.

Table 2-5    48-Key Descriptions (Continued)

Key Description

. . .

ALT ALT

. . .
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Windows CE Demo Window
On initial power up (or on a warm or cold boot) the Demo window appears. This window links to the Test 
Applications window and the two windows provide the sample/demo applications. The sample/demo applications 
are intended to be used by application developers as application development examples. These applications were 
not developed to support end users. Refer to the Application Guide for Motorola Enterprise Mobility Devices for the 
Demo window applications.

Figure 2-5    Demo Window

Windows CE Desktop
To access the desktop tap the Exit icon on the Demo window or tap the Desktop Display button. See Figure 2-7 
on page 2-14 for the Desktop Display button location. The desktop displays the applications available with the 
Windows CE .NET 5.0 Professional and with the Windows CE .NET 5.0 Core configurations. For information on 
using the Microsoft® Applications refer to the Microsoft® Applications for Mobile and CE 5.0 User Guide, p/n 
72E-78456-xx.

Figure 2-6    Desktop Window

Test Applications WindowDemo Window

NOTE The Demo window is the factory default launcher menu. Application specific shells may vary.

Windows CE .NET 5.0 Core DesktopWindows CE .NET 5.0 Professional Desktop
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Windows CE Status Icons
The taskbar (at the bottom of the screen) displays the Start button, active programs, battery status and 
communication status. The taskbar icons are described in Table 2-6. The taskbar icons display the function status, 
indicate what programs are active and indicate the battery charge status. The Taskbar buttons are used to access 
menus, select/deselect functions or to change display windows.

• Status Icons: The status icons indicate the function key status. If the FUNC, SHIFT, CTRL, ALT or ALPHA 
functions are active the appropriate status icon is displayed. 

• Active Programs Icons: The active applications icons are displayed on the taskbar. If more than one program 
is active, icons can be used to toggle between the open programs (applications). Tap on a taskbar application 
to maximize the application. 

• AC Power/Battery Status Icons: The AC Power/Battery Status icons are shown in the taskbar to indicate the 
present power supply status of the mobile computer. The main battery status icons provide the battery status 
in 10% increments from 10% to 100%. The backup battery low icon indicates that the backup battery charge 
is low. See Battery Charging on page 1-7 for backup battery charging instructions.

Figure 2-7    Taskbar

Table 2-6    Taskbar Icons

Icon Description

Indicates that the battery is charging.

Indicates that the battery is fully charged (100% charged).
The battery status icons provide the battery status in 10% increments from 10% to 100%.

Indicates that communication with the smart battery has not been established. After a mobile computer 
reset, this icon may be displayed for up to 30 seconds. See, Battery Unknown Icon on page 2-15 for 
additional information.

Indicates that the backup battery is low.

Indicates that the battery is fully charged and the mobile computer is running on external power.

Indicates IP status. Only displays when the mobile computer is in emulation mode.

Indicates that the ActiveSync application is running.

Indicates that the wireless application radio is connected to a wireless LAN network with excellent signal 
strength. See Table 2-13 on page 2-37 for all of the signal strength icons.

Start Button

Open Programs and Status Icons

Keyboard Input Panel Button

Desktop Display Button

Window Title Scroll Status Icons
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Battery Unknown Icon

The Battery Unknown icon displays when communication with the smart battery has not been established. As part 
of normal operation this icon may be displayed for 30 seconds following a mobile computer reset. 

If the icon displays beyond this 30 second period:

1. Remove and re-seat the battery.

2. If after re-seating the battery, the icon remains, warm boot the mobile computer.

3. If after warm booting the mobile computer, the icon remains, then cold boot the mobile computer.

4. If after cold booting the mobile computer, the icon remains, install a new (tested and working) battery.

5. If the icon remains, return the mobile computer for servicing.

Start Button

Tap the Start button to launch the Start menu.

• Programs: Use to access available programs.

• Favorites: Displays files in Favorites directory.

• Documents: Displays files in Documents directory.

• Settings: Accesses the Control Panel, the Network and Dial-up Connections and the Taskbar and Start 
menu.

Indicates that the wireless application radio is not connected to a wireless LAN network. 

The Bluetooth Enabled icon appears in the task tray and indicates that the Bluetooth radio is on.

The Bluetooth Disabled icon appears in the task tray and indicates that the Bluetooth radio is off.

The Bluetooth Communication icon appears in the task tray and indicates that the mobile computer is 
communicating with another Bluetooth device.

Indicates that the SHIFT button function is selected.

Indicates that the FUNC button function is selected.

Indicates that the CTRL button function is selected.

Indicates that the ALT character selection is selected.

Indicates that the mobile computer is in ALPHA button mode is selected.

Table 2-6    Taskbar Icons (Continued)

Icon Description

ALT
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• Help: Accesses the Windows CE Help. Not available on mobile computers running Windows CE .NET 5.0 
Core.

• Run . . . : Runs a program or application.

• Suspend: Places the mobile computer in the suspend state.

Figure 2-8    Start Menu

Programs Menu

From the Start menu, tap Programs to launch the Programs menu. The programs provided with Windows CE .NET 
5.0 Professional and Windows CE .NET 5.0 Core are displayed in the Programs menu. Refer to the Application 
Guide for Motorola Enterprise Mobility Devices, p/n 72-68901-xx and the Microsoft® Applications for Mobile and CE 
5.0 User Guide, p/n 72E-78456-xx for application information.

Figure 2-9    Programs Menu

Keyboard Input Panel Button

Use the Keyboard Input Panel as an alternate input device. For more information, see Entering Information Using 
the Keyboard Input Panel on page 2-25.

Desktop Display Button

Use the Desktop Display button to minimize all open programs and display the desktop. 

Windows CE .NET 5.0 Professional Windows CE .NET 5.0 Core
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Windows CE .NET 5.0 Core desktop functions include:

• My Computer: Double-tap the icon to open My Computer.

• Recycle Bin: Deleted files remain in the recycle bin until the recycle bin is emptied. Once emptied the files 
cannot be retrieved.

Windows CE .NET 5.0 Professional desktop functions include:

• My Computer: Double-tap the icon to open My Computer.

• Recycle Bin: Deleted files remain in the recycle bin until the recycle bin is emptied. Once emptied the files 
cannot be retrieved.

• Remote Desktop Connection: Tap the Remote Desktop Connection icon to access the Remote Desktop 
Connection window.

Task Manager and Properties
Use the Task Manager to control an application’s use and use the Properties functions to set display and clock 
options.

Task Manager

1. Select FUNC - CTRL, (to activate the ALT state) and tap on the taskbar to display the Task Manager, 
Properties Selection menu.

Figure 2-10    Task Manager, Properties Selection Menu

2. Tap Task Manager to display the Task Manager window.

Figure 2-11    Task Manager Window

3. Tap a task in the Active Tasks list and tap Switch To to make that task the primary task, or tap End Task to end 
the selected task.

4. Tap X to exit the Task Manager window.

NOTE The 20-key mechanical keypad does not contain a CTRL key.
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Properties

1. Tap Start > Control Panel > Taskbar and Start Menu ... . The Task Manager, Properties window displays, 
see Figure 2-10 on page 2-17.

2. Tap Properties to display the Taskbar and Start Menu, General tab. 

3. This menu provides taskbar options:

• Check the Always on Top checkbox to keep the taskbar on top of all other windows. 

• Check the AutoHide checkbox to make the taskbar disappear, touch the bottom of the display to make the 
taskbar return.

• Check the Show Clock checkbox to display the clock on the taskbar.

4. Tap OK to save the settings and exit the window.

Figure 2-12    Taskbar and Start Menu, General Tab

Advanced Tab

1. Tap the Advanced tab to enter the Taskbar and Start Menu, Advanced tab.

2. Tap the Clear button to delete all of the documents listed in the Start > Documents entry, see Start Button on 
page 2-15. Typically this list is empty, but if there were documents in the list the Clear button would delete 
them.

3. Tap the Expand Control Panel checkbox to display the entire contents of the MS control panel in list form, 
rather than icons.

Figure 2-13    Taskbar and Start Menu, Advanced Tab

4. Tap OK to save the settings and exit the window.
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Windows Mobile 6.1 Today Screen
The Today screen displays important information, such as upcoming appointments and status indicators. Tap a 
section on the screen to open the associated program. Alternatively, tap Start > Today to display the Today 
screen.

Figure 2-14    Today Screen

To customize the Today screen, tap Start > Settings > Today icon. Use the Appearance tab to customize the 
background and the Items tab to change the list and order of items that appear on the screen.

Windows Mobile 6.1 Status Icons

Status Bar

Status icons are shown in the Status Bar to indicate present status of the mobile computer. Tapping each status 
icon displays the corresponding dialog box and enables you to change or adjust its settings. You may see the 
status icons listed in Table 2-7 on the Status Bar located at the top of the screen.

Open the Start Menu Adjust volume

Change the date and time

Soft Keys

Battery Status

Command Bar

Turn on or off radios

BTExplorer

Wireless Applications

Notification
Connectivity

Table 2-7    Status Icons

Icon Function Description

 Audio Speaker is on.

Speaker is off.

* Only appears in the Time and Next Appointment dialog box.
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Command Bar

You may see the icons listed in Table 2-8 on the Command Bar located at the bottom of the screen.

Figure 2-15    Command Bar

 Battery Backup battery is very low.

 Main battery is charging.*

Main battery level.*

 Main battery is very low.*

 Connectivity Connection is active.

ActiveSync error

 Synchronization is occurring.

 Instant Message Notification that one or more instant messages were received.

 E-Mail Notification that one or more e-mail messages were received.

Time and Next 
Appointment

Displays current time in analog or digital format.

 Multiple Notifications There are more notification icons than can be displayed. Tap to display 
remaining icons.

Table 2-7    Status Icons (Continued)

Icon Function Description

* Only appears in the Time and Next Appointment dialog box.

Table 2-8    Command Bar Icons

Icon Description

Wireless connection status icon. Indicates WLAN signal strength and opens the Wireless 
Applications menu.

The Bluetooth Enabled icon appears in the task tray and indicates that the Bluetooth radio is on.

Status Icons
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Speaker Icon

You can adjust the system volume using the Speaker icon in the Status bar.

1. Tap the Speaker icon. The Volume dialog box appears.

Figure 2-16    Volume Dialog Box

2. Tap and move the slide bar to adjust the volume.

3. Select the On or Off radio button to turn the volume on or off.

Battery Icons

The Main Battery icon appears in the Title Bar when the Today screen is visible. The icon indicates the battery 
power level.

The Bluetooth Disabled icon appears in the task tray and indicates that the Bluetooth radio is off.

The Bluetooth Communication icon appears in the task tray and indicates that the mobile 
computer is communicating with another Bluetooth device.

The ActiveSync icon appears in the task tray and indicates an active serial connection between the 
mobile computer and the development computer.

Table 2-8    Command Bar Icons (Continued)

Icon Description

NOTE Use can also adjust the system volume using the Sounds & Notifications window or by using the 
keypad special functions. See Keypad Special Functions on page 2-2.
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Figure 2-17    Battery Icon on the Title Bar

You can also view the battery status using the Power window.

When the main battery power falls below a predetermined level a Main Battery dialog box appears indicating the 
status of the main battery. When the backup battery power falls below a predetermined level a Backup Battery 
icon and dialog box appears indicating the status of the backup battery.

Figure 2-18    Battery Status Icons and Dialog Boxes

Connectivity Icon

The Connectivity icon indicates the communication status of the terminal when it’s connecting to the internet or 
host computer.

Figure 2-19    Connectivity Dialog Box

Time Icon

The Time icon displays the current time in a digital or analog format. To change the time format, tap and hold the 
Time icon until a menu appears. Select the format you want.

NOTE The Time icon only appears in the Title Bar when an application displays. It does not appear it the Title 
Bar when the Today screen displays.
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Figure 2-20    Time Icon Format Menu

To display current date, time and appointments:

1. Tap the Time icon to display the Time and Next Appointment dialog box.

Figure 2-21    Time and Next Appointment Dialog Box

2. The dialog box displays the current date and time, the battery status and any upcoming appointments in the 
Calendar.

E-Mail Icon

The E-Mail icon notifies you when you have received incoming e-mails.

Figure 2-22    New E-mail Messages Dialog Box

Multiple Notification Icon

The Multiple Notification icon appears when two or more message notifications occur. Tap the icon to display the 
multiple notification icons.

Analog ClockDigital Clock

Battery Status Icon
Upcoming Appointments

Current Date and Time



2 - 24 MC3000 User Guide
Figure 2-23    Multiple Notifications Icon

Locking the Mobile Computer (Windows Mobile 6.1 Only)
Use the Device Lock feature to prevent use of the device. Note that when locked, the mobile computer does not 
respond to screen or keypad input.

To lock the device, tap the Device unlocked icon. The icon changes to locked.

Figure 2-24    Device Locked/Unlocked Icons

To unlock the device and free it for use, tap Unlock.

Figure 2-25    Unlock Device Window

Tap Unlock on the Unlock Device window.
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Entering Information
To enter information:

• Use the keypad.

• Use the keyboard input panel (soft keyboard) to enter text.

• Scan bar code data into data fields.

• Use Microsoft® ActiveSync® to synchronize or copy information from the host computer to the mobile 
computer. For more information on ActiveSync, refer to the MC3000 Integrator Guide.

Entering Information Using Keypad

The 28, 38 and 48-key alphanumeric keypads produce the 26-character alphabet (A - Z), numbers (0 - 9), function 
keys and assorted characters. The keypads default characters/functions are printed black or white, the ALPHA 
character/functions are printed orange and the FUNC character/functions are printed blue. The 20-key mechanical 
keypad produces numbers (0 - 9) and function key and various characters. See Keypads on page 2-1 for keypad 
configurations, see Table 2-1 on page 2-2 for keypad special functions and see Table B-1 on page B-2 for the 
special character generation.

Entering Information Using the Keyboard Input Panel

Use the keyboard input panel (soft keyboard) to enter information in any program. To launch the keyboard input 
panel, tap the  button on the taskbar. Tap a key to enter the value. Tap the keyboard input panel button to 
display or to hide the keyboard input panel.

Figure 2-26    Keyboard Input Panel

Entering Data via the Bar Code Scanner

The sample bar code scanner application scans data into data fields in the same way data is entered via the 
keypad.

Windows CE 5.0 Windows Mobile 6.1
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Using a Bluetooth Headset
You can use a Bluetooth headset for audio communication when an audio enabled application is used. See 
Chapter 3, Using Bluetooth for information on connecting a Bluetooth device to the mobile computer. Ensure that 
the mobile computer’s volume is set appropriately before putting the headset on. When a Bluetooth headset is 
connected the speaker is muted.

Data Capture
The mobile computer has an integrated scanner or imager that collects data by scanning bar codes.

Laser Scanning

To scan bar codes with the mobile computer:

1. Ensure that the mobile computer is loaded with a scanning application. 

2. If the mobile computer is equipped with a rotating head, adjust the head prior to scanning.

3. Aim the scan window at the bar code.

4. Press the scan button or trigger. Ensure the red scan beam covers the entire bar code. The Scan LED 
Indicators illuminate red to indicate that the laser is on. The Scan LED Indicators illuminate green and a beep 
sounds to indicate a successful decode.

Figure 2-27    Laser Aiming

Optimal scanning distance varies with bar code density and scanner optics.

• Hold the scanner farther away for larger symbols.

• Move the scanner closer for symbols with bars that are close together.

NOTE If the mobile computer goes into suspend mode the Bluetooth connection is disabled and the mobile 
computer automatically switches to speakerphone mode.

WrongRight

NOTE Scanning procedures depend on the application and mobile computer configuration. An application may use 
different scanning procedures from the one listed above.
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Scan LED Indicators

The red/green Scan LED Indicators (located in the Indicator LED Bar and in the rotating turret) indicates the scan 
status. For the location of the Scan LED Indicators see, Figure 1-1 on page 1-3. 

Scanning Considerations

Scanning consists of; aim, scan and decode. Scanning performance can be optimized by considering the range 
and the scanning angle:

• Range
Any scanning device decodes well over a particular working range (minimum and maximum distances from 
the bar code). This range varies according to bar code density and scanning device optics.
Scanning within range brings quick and constant decodes; scanning too close or too far away prevents 
decodes. Move the scanner closer and further away to find the right working range for the bar codes being 
scanned. However, the situation is complicated by the availability of various integrated scanning modules. 
The best way to specify the appropriate working range per bar code density is through a chart called a 
decode zone for each scan module. A decode zone simply plots working range as a function of minimum 
element widths of bar code symbols.

• Angle
The scan angle is important for optimizing decode performance. When laser beams reflect directly back into 
the scanner from the bar code, this specular reflection can “blind” the scanner.
To avoid this, scan the bar code so that the beam does not bounce directly back. But do not scan at too sharp 
an angle; the scanner needs to collect scattered reflections from the scan to make a successful decode. 
Practice quickly shows what tolerances to work within.

Laser Decode Ranges

The decode ranges provide the decode ranges for barcodes of specified densities. Figure 2-28 shows the laser 
decode ranges and Table 2-10 on page 2-28 lists the scan ranges for the selected bar code densities. The 
minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the 
symbol. The maximum usable length of a symbol at any given range is shown below. 

Table 2-9    Scan LED Indicators

LED Status Indication

Off Not scanning.

Solid Red Laser enabled, scanning in process.

Solid Green Successful decode.

NOTE Contact the Motorola Enterprise Mobility Support Center if chronic scanning difficulties develop. Decoding of 
properly printed bar codes should be quick and effortless.
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Figure 2-28    MC3000 Laser Decode Ranges

Table 2-10     MC3000 Laser Decode Ranges

Bar Code Density
Ranges

Near Far

5.0 mil 2.0 in
5.08 cm

4.9 in
12.45 cm

7.5 mil 1.6 in
4.06 cm

7.9 in
20.07 cm

10 mil 1.2 in
3.05 cm

10.8 in
67.95cm

 UPC A 1.3 in 
3.30 cm

12.7 in
32.26 cm

in.
cm

MC3000

5 mil 4.9

7.5 mil

10 mil

7.9

10.8

12.7

17.9

26.4

20 mil

40 mil

30.6
55 mil
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Note:  Typical performance at 73˚ F (23˚ C) 
           on high quality symbols.
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Imaging
The imager version of the mobile computer has the following features:

• Omnidirectional reading of a variety of bar code symbologies, including the most popular linear, postal, 
PDF417 and 2-D matrix code types.

• The ability to capture and download images to a host for a variety of imaging applications.

• Advanced intuitive laser aiming for easy point-and-shoot operation.

Imager

The imager uses digital camera technology to take a digital picture of a bar code, the image is stored in memory 
and software decoding algorithms are executed to extract the data from the image. A typical bar code decoding 
process is as follows:

1. Aim the mobile computer at a bar code and press the scan button or trigger.

2. The red laser aiming pattern turns on to assist in aiming the mobile computer.

3. The mobile computer turns on the secondary white LEDs to illuminate the target bar code.

4. The mobile computer takes a digital picture (image) of the bar code and stores it in memory for decoding. A 
beep sounds to indicate that the bar code was properly decoded.

5. Release the scan button.

This process usually occurs instantaneously. Steps 2 - 4 are repeated on poor or difficult bar codes as long as the 
scan button remains active. 

Operational Modes

Mobile computers with an integrated imager have three modes of operation: Decode Mode, Pick List Mode and 
Image Capture Mode. All modes are activated by pulling the trigger or pressing the Scan button.

Decode Mode

This mode allows the user to decode a bar code when a single bar code in the mobile computer’s field of view. In 
this mode the Imager attempts to locate and decode enabled bar codes within its field of view. The Imager remains 
in this mode as long as the trigger is pulled, or until a bar code is decoded.

20 mil 1.4 in 
3.56 cm

17.9 in
45.47 cm

40 mil 2.4 in
6.10 cm

26.4 in
67.06 cm

55 mil 3.4 in
8.64 cm

30.6 in
77.72 cm

Table 2-10     MC3000 Laser Decode Ranges (Continued)

Bar Code Density
Ranges

Near Far
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Pick List Mode

Pick List mode allows the user to selectively decode a bar code when more than one bar code is in the mobile 
computer’s field of view. By moving the aiming crosshair over the wanted bar code the user can selectively read 
only the required bar code. This feature is particularly valued for pick lists containing multiple bar codes and 
manufacturing or transport labels containing more than one bar code type (either 1D or 2D).

Aiming the Mobile Computer

The imager version of the mobile computer projects a laser aiming pattern (shown below) similar to those used on 
cameras. The aiming pattern is used to position the bar code or object within the field of view.

Figure 2-29    Laser Aiming Pattern

To scan a symbol using the imager:

1. Center the symbol in any orientation within the aiming pattern. Ensure the entire symbol is within the 
rectangular area formed by the brackets in the aiming pattern.

Figure 2-30    Centering Symbol in Aiming Pattern

The imager can also read a bar code presented within the aiming pattern but not centered, such as the figure 
below on the left. The figure on the right, however, can not be decoded.

Figure 2-31    Bar Code not Centered in Aiming Pattern

Note that when the mobile computer is in Pick List Mode, the bar code is not decoded until the crosshair is 
touching the bar code.

Linear bar code PDF417 symbol

Symbol

View Finder
(Aiming Pattern)

Right Wrong
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Figure 2-32    Pick List Mode with Multiple Bar Codes in Aiming Pattern

2. The aiming pattern is smaller when the Imager is closer to the symbol and larger when it is farther from the 
symbol. Scan symbols with smaller bars or elements (mil size) closer to the unit and those with larger bars or 
elements (mil size) farther from the unit.

3. Hold the mobile computer between two and nine inches (depending on symbol density) from the symbol, 
centering the aiming pattern cross hairs on the symbol. 

4. Press the scan button. The Scan LED Indicators illuminate red to indicate that the laser is on. The Scan LED 
Indicators illuminate green and a beep sounds to indicate a successful decode.

Imager Decode Ranges

The decode ranges provide the decode distances for barcodes of specified densities. Figure 2-33 shows the 
imager decode ranges and Table 2-11 on page 2-32 lists the scan ranges for the selected bar code densities. The 
minimum element width (or “symbol density”) is the width in mils of the narrowest element (bar or space) in the 
symbol. The maximum usable length of a symbol at any given range is shown below. 
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Figure 2-33    MC3000 Imager Decode Ranges

Table 2-11     MC3000 Imager Decode Ranges

Bar Code Density
Ranges

Near Far

5.0 mil 4.5 in
11.43 cm

6.5 in
16.51cm

7.5 mil 3.3 in
8.38 cm

10.7 in
27.18 cm

UPC A 2.5 in
6.35 cm

14.2 in
36.07cm

20 mil 2.8 in 
7.11 cm

18.9 in
48.01 cm

in.
cm

MC3000

5 mil 6.5

PDF417 6.67 mil

7.5 mil

7.7

10.7

11.1

14.2

14.4

UPC A

PDF417 15 mil

18.9
20 mil
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Note:  Typical performance at 73˚ F (23˚ C) 
           on high quality symbols.
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PDF417 10 mil
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2.8
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5 12.7
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15.246

15.246
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Direct Part Marking

Direct Part Marking (DPM) is where an item is physically altered by methods such as dot peening, laser and 
electro-chemical etching to produce two different surface conditions. These marking result in the symbol being 
created by either smooth and rough (or dull and shiny) areas on the substrate or a symbol comprised “dots” below 
or above the substrate surface. DPM is typically used with matrix symbologies. As a result, there is often very little 
or no contrast between the “marked” elements of a symbol and the background.

Figure 2-34    Examples of Direct Part Marking

To scan a DPM symbol using the imager:

1. Center the symbol in any orientation within the aiming pattern. Ensure the entire symbol is within the 
rectangular area formed by the brackets in the aiming pattern.

Figure 2-35    Centering Symbol in Aiming Pattern

2. The aiming pattern is smaller when the Imager is closer to the symbol and larger when it is farther from the 
symbol. Scan symbols with smaller elements closer to the unit and those with larger elements farther from the 
unit.

3. Hold the mobile computer between two and nine inches (depending on symbol density) from the symbol, 
centering the aiming pattern cross hairs on the symbol. Do not aim the exit window directly at the surface to 
avoid reflection back into the imager. Hold at a slight angle.

PDF417 6.67 mil 5.3 in 
13.46 cm

7.7 in
19.56 cm

PDF417 10 mil 4.3 in
10.92 cm

11.1 in
28.19 cm

PDF417 15 mil 3.8 in
9.65 cm

14.4 in
36.58 cm

Table 2-11     MC3000 Imager Decode Ranges (Continued)

Bar Code Density
Ranges

Near Far

LaserDot Peening

Symbol

View Finder
(Aiming Pattern)
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4. Press the scan button. The Scan LED Indicators illuminate red to indicate that the laser is on. The Scan LED 
Indicators illuminate green and a beep sounds to indicate a successful decode.

Resetting the Mobile Computer

Windows CE Devices

If the mobile computer stops responding to input, reset it. There are two reset functions, warm boot and cold boot. 
A warm boot restarts the mobile computer by closing all running programs. All data that is not saved is lost.

A cold boot also restarts the mobile computer, but erases all stored records and entries from RAM. In addition it 
returns formats, preferences and other settings to the factory default settings.

Perform a warm boot first. If the mobile computer still does not respond, perform a cold boot.

Performing a Warm Boot

To perform a warm boot on 28, 38 and 48-key keypad configurations:

1. Press and simultaneously hold 7, 9 and Power. Do not hold down any other keys or buttons.

2. As the mobile computer initializes MC3000 demo window appears.

To perform a warm boot on 20-key keypad configurations:

1. Press and simultaneously hold the 7 and 9 keys and the press the MENU and Fn keys. Do not hold down any 
other keys or buttons.

2. As the mobile computer initializes MC3000 demo window appears.

Performing a Cold Boot

A cold boot restarts the mobile computer and erases all user stored records and entries from RAM. Never perform 
a cold boot unless a warm boot does not solve the problem.

To perform a cold boot 28, 38 and 48-key keypad configurations:

1. Simultaneously press and then release the 1, 9 and Power keys. Do not hold down any other keys or buttons. 
As the mobile computer initializes, the splash window, Figure 1-7 on page 1-9, appears for about a minute.

2. Calibrate the touch screen. See Calibration Screen on page 1-10 to calibrate the mobile computer screen.

To perform a cold boot on 20-key keypad configurations:

1. Simultaneously press and then release the 1 and 9, MENU and Fn keys. Do not hold down any other keys or 
buttons. As the mobile computer initializes, the splash window, Figure 1-7 on page 1-9, appears for about a 
minute.

CAUTION Files that remain open during a warm boot may not be retained.

CAUTION Files that remain open during a warm boot may not be retained.

CAUTION Cold boot resets the mobile computer, to the default settings. All added applications and all stored data are 
removed. Do not cold boot without support desk approval.
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2. Calibrate the touch screen. See Calibration Screen on page 1-10 to calibrate the mobile computer screen.

Windows Mobile 6.1 Devices

There are two reset functions, warm boot and cold boot.

• A warm boot restarts the mobile computer and closes all running programs.

• A cold boot also restarts the mobile computer and closes all running programs but also resets the 
Real-Time-Clock (RTC).

Data saved in flash memory or a memory card is not lost. Perform a warm boot first. This restarts the mobile 
computer and saves all stored records and entries. If the mobile computer still does not respond, perform a cold 
boot.

Performing a Warm Boot

To perform a warm boot on 28, 38 and 48-key keypad configurations:

1. Press and simultaneously hold 7, 9 and Power. Do not hold down any other keys or buttons.

2. As the mobile computer initializes Today screen appears.

Performing a Cold Boot

A cold boot restarts the mobile computer. The operating system and all applications are restarted. File storage is 
preserved. The Real-Time-Clock (RTC) resets. Only perform a cold boot if a warm boot does not solve the 
problem.

1. To perform a cold boot 28, 38 and 48-key keypad configurations, simultaneously press and then release the 1, 
9 and Power keys. Do not hold down any other keys or buttons.

2. As the mobile computer initializes, the splash window, Figure 1-7 on page 1-9, appears for about a minute.

Waking the Mobile Computer
The wakeup conditions define what actions wake up the mobile computer after it has gone into suspend mode. The 
mobile computer can go into suspend mode by either pressing the Power button or automatically by Control Panel 
time-out settings. These settings are configurable and the factory default settings are shown in Table 2-12.

Table 2-12    Wakeup Default Settings

Condition for Wakeup Power Button Automatic Time-out

AC power is applied. No Yes

Mobile computer is inserted into a cradle. No Yes

Mobile computer is removed from a cradle. No Yes

Mobile computer is connected to a serial device. No Yes

Mobile computer is connected to a USB device. No Yes

Mobile computer is disconnected from a USB device. No Yes

A key is pressed. No Yes
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File System Directory Structure
The mobile computer directory structure displays all of the file folders. The pre-installed folders are in flash file 
system memory and optional removable storage devices (SD storage cards).

Figure 2-36    Mobile Computer Directory Structure

• Application and Platform folders are located in flash file system memory. 

• The Windows, Program Files, profiles, and My Documents folders are composites, RAM based folders 
generated from ROM (many of these files are marked read only). 

• The Network folder is a link to file systems mapped using the network redirector. The files do not physically 
reside on the mobile computer.

• The Temp and Recycled folders typically contain RAM based files.

Connecting to the Internet on a Wireless LAN Network
The mobile computer can connect to the Internet across a wireless LAN network. The Wireless Applications utility 
starts automatically when the mobile computer is turned on and the wireless application icon appears in the taskbar 
to indicate the connection and the signal strength status. Before attempting a wireless internet connection, confirm 

The scan triggered is pressed. No Yes

The screen is touched. No No

Wireless LAN activity is detected. No No

Table 2-12    Wakeup Default Settings (Continued)

Condition for Wakeup Power Button Automatic Time-out

NOTE All files copied to the RAM based folders are lost after a cold boot.
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that the wireless application radio is connected to a wireless LAN network. If the WLAN radio is not connected or if 
the signal strength is not “Good” or better, contact the network administrator.

To connect using Internet Explorer (IE) tap Start > Programs > Internet Explorer to start Internet Explorer.

Figure 2-37    Typical Internet Explorer (IE) Connection

Table 2-13    Wireless Applications Icons, Signal Strength Descriptions

Icon Status Action

Excellent signal strength Wireless LAN network is ready to use.

Very good signal strength Wireless LAN network is ready to use.

Good signal strength Wireless LAN network is ready to use.

Fair signal strength Wireless LAN network is ready to use. Notify the network administrator 
that the signal strength is only “Fair”.

Poor signal strength Wireless LAN network is ready to use. Performance may not be optimum. 
Notify the network administrator that the signal strength is “Poor”.

Out-of-network range (not 
associated)

No wireless LAN network connection. Notify the network administrator.

No wireless LAN network card 
detected.

No wireless LAN network card detected. Notify the network administrator.

NOTE IE is not provided on mobile computers with Microsoft® Windows CE .NET 5.0 Core.
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Chapter 3 Using Bluetooth
Introduction
Bluetooth-equipped devices can communicate without wires, using frequency-hopping spread spectrum (FHSS) 
RF to transmit and receive data in the 2.4 GHz Industry Scientific and Medical (ISM) band (802.15.1). Bluetooth 
wireless technology is specifically designed for short-range (30 feet/10 meters) communications and low power 
consumption.

Mobile computers with Bluetooth capabilities can exchange information (e.g., files, appointments and tasks) with 
other Bluetooth enabled devices such as phones, printers, access points and other mobile computers. In addition, 
a dial-up modem connection can be created between the Bluetooth mobile computer and a Bluetooth enabled 
phone. The Bluetooth phone can then be used as a modem.

Motorola mobile computers with Bluetooth technology use the StoneStreet One Bluetooth stack. To program 
Bluetooth within the mobile computer refer to the StoneStreet One SDK.

Adaptive Frequency Hopping
Adaptive Frequency Hopping (AFH) is a method of avoiding fixed frequency interferers. AFH can be used with 
Bluetooth voice. All devices in the piconet (Bluetooth network) must be AFH-capable in order for AFH to work. 
There is no AFH when connecting and discovering devices. Avoid making Bluetooth connections and discoveries 
during critical 802.11b communications. AFH for Bluetooth can be broken-down into four main sections:

• Channel Classification - A method of detecting an interference on a channel-by-channel basis, or pre-defined 
channel mask.

• Link Management - Coordinates and distributes the AFH information to the rest of the Bluetooth network.

• Hop Sequence Modification - Avoids the interference by selectively reducing the number of hopping 
channels.

• Channel Maintenance - A method for periodically re-evaluating the channels.

When AFH is enabled, the Bluetooth radio “hops-around” (instead of through) the 802.11b high-rate channels. AFH 
coexistence allows Motorola mobile computers to operate in any infrastructure. AFH is always enabled in the 
MC3000.

The Bluetooth radio in this mobile computer operates as a Class 2 device power class. The maximum output power 
is 2.5mW and the expected range is up to 32.8 feet (10 meters). A definitive definition of ranges based on power 
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class is difficult to obtain due to power and device differences, and whether one measures open space or closed 
office space. 

Security
The current Bluetooth specification defines security at the link level. Application-level security is not specified. This 
allows application developers to define security mechanisms tailored to their specific need. Link-level security is 
really between devices not users, while application-level security can be implemented on a per-user basis. The 
Bluetooth specification defines security algorithms and procedures needed to authenticate devices, and if needed, 
encrypt the data flowing on the link between the devices. Device authentication is a mandatory feature of Bluetooth 
while link encryption is optional.

Pairing of Bluetooth devices is accomplished by creating an initialization key that is used to authenticate the 
devices and create a link key for them. Entering a common PIN number in the devices being paired generates the 
initialization key. The PIN number is never sent over the air. By default, the Bluetooth stack responds with no key 
when a key is requested (it is up to user to respond to the key request event). Authentication of Bluetooth devices 
is based-upon a challenge-response transaction. Bluetooth allows for a PIN number or passkey that is used to 
create other 128-bit keys used for security and encryption. The encryption key is derived from the link key used to 
authenticate the pairing devices. Also worthy of note is the limited range and fast frequency hopping of the 
Bluetooth radios that makes long-distance eavesdropping difficult.

It is recommended:

• Perform pairing in a secure environment

• Keep PIN codes private and don't store the PIN codes in the mobile computer

• Implement application-level security.

Turning the Bluetooth Radio Mode On and Off
Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When the 
radio is off, the mobile computer can not be seen or connected to by other Bluetooth devices. Turn on the Bluetooth 
radio to exchange information with other Bluetooth devices (within range). Communicate only with Bluetooth radios 
in close proximity.

Disabling Bluetooth

To disable Bluetooth, tap Bluetooth icon > Disable Bluetooth. The Bluetooth icon changes to indicate that Bluetooth 
is disabled. An exclamation point appears with the icon.

NOTE It is not recommended to perform Bluetooth wireless technology inquiry when high rate 802.11b operation is 
required.

NOTE To achieve the best battery life in mobile computers with multiple radios, turn off the radios that are not being 
used. 



Using Bluetooth 3 - 3
Figure 3-1    Disable Bluetooth

Enabling Bluetooth

To enable Bluetooth, tap Bluetooth icon > Enable Bluetooth. The Bluetooth icon changes to indicate that Bluetooth 
is enabled.

Figure 3-2    Enable Bluetooth

Bluetooth Power States

Cold Boot

When a cold boot is performed on the mobile computer, Bluetooth turns off. It is normal to see the Bluetooth icon 
appear and disappear, as well as a wait cursor, when initialization proceeds in all modes.

Warm Boot

When a warm boot is performed on the mobile computer, Bluetooth returns to the disabled state (off).
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Suspend

When the mobile computer suspends, Bluetooth turns off.

Resume

When the mobile computer resumes, Bluetooth turns on if it was on prior to suspend. Note that any Bluetooth 
connection that was dropped during a suspend needs to be reconnected after a resume.

Bluetooth Profiles
The mobile computer is loaded with a number of Bluetooth services profiles. These profiles can be loaded or 
removed from memory. If a profile is not used, it can be removed to save memory. To load or remove profiles:

1. If BTExplorer is running, tap  > Disable Bluetooth.

2. Tap  > Programs > BTProfileSelctor. The ProfileSelector window appears.

Figure 3-3    Bluetooth Profile Selector Window

3. Tap a check box next to the profile to load (activate).

The Serial Port profile is always active and cannot be removed.

4. Tap Select All to select all profiles or tap Deselect All to deselect all profiles.

5. Tap Apply to activate the profiles and then Close to exit the application.

6. Tap  > Enable Bluetooth to enable BTExplorer application.

See Services Tab on page 3-22 for more information on selecting services.

NOTE When the mobile computer is placed in suspend mode, the Bluetooth radio mode powers off and the piconet 
(Bluetooth connection) is dropped. When the mobile computer resumes, it could take up to 10 seconds for the 
Bluetooth radio driver to re-initialize the radio.
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Modes
The BTExplorer application has two mode for managing Bluetooth connections: Wizard Mode and Explorer Mode. 
The Wizard Mode is for novice Bluetooth users and the Explorer Mode is for experienced Bluetooth users.

Wizard Mode

Wizard Mode provides a simple step by step process for discovering and connecting to Bluetooth devices. The 
wizard takes you through the entire process.

The following steps provide an example for using the Wizard to services for remote devices.

1. Tap the Bluetooth icon and select Show BTExplorer. The BTExplorer window appears.

2. Tap File > New Connection. The New Connection Wizard window appears.

Figure 3-4    New Connection Wizard Window

3. Select an action from the drop-down list. In this example, Explore Services on Remote Device is selected.

4. Tap Next. The BTExplorer searches for Bluetooth devices in the area and displays the devices in the Select 
Remote Device window.

NOTE When switching between Wizard Mode and Explorer Mode, all active connections are closed. 
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Figure 3-5    Select Remote Device Window

5. Select a device from the list and then tap Next. The Connection Favorite Options window appears.

Figure 3-6    Connection Favorite Options Window

6. Select Save As Favorite check box to save this service in the Favorite view.

7. In the Favorite Name text box, enter a name for this service that will appear in the Favorite list.

8. Tap Next. The Connection Summary window appears.

NOTE Devices discovered previously are listed to save time. To start a new device discovery, tap and hold and select 
Discover Devices from the menu.
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Figure 3-7    Connection Summary Window

9. Tap Connect to connect to the service.

The following actions are available in the drop-down list (actions may vary depending upon configurations):

• Explore Services on Remote Device

• Pair with a Remote Device

• ActiveSync via Bluetooth

• Browse Files on Remote Device

• Connect to Internet Using Access Point

• Connect to Internet Using Phone/Modem

• Connect to a Personal Area Network

• Send or Exchange Objects

• Associate Serial Port.

Explorer Mode

The BTExplorer window is streamlined and easy to navigate and provides greater control to users familiar with 
Bluetooth functionality. The menu bar provides quick access to the options and tools used to connect to devices.

Figure 3-8    Explorer Mode Window
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You can also use the “tap and hold” technique to view available options. Scroll bars and view options are like those 
you’re familiar with on your Windows desktop. The tree structure lists the following sub-items:

• Local Device - This MC3000 mobile computer

• Remote Device - Other Bluetooth devices
• Trusted Devices - Bonded (paired) Bluetooth devices
• Untrusted Devices - Discovered devices that are not bonded

• Favorites - Selected services that are set as being Favorite for quick access.

Discovering Bluetooth Device(s)
Follow the steps below to discover Bluetooth devices. The mobile computer can receive information from 
discovered devices, without bonding. However, once bonded, an exchange of information between the mobile 
computer and a bonded device occurs automatically when the Bluetooth radio is turned on.

To find Bluetooth devices in the area:

1. Ensure that the Bluetooth device being looked for is in discoverable mode.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. Tap the Bluetooth icon and select Show BTExplorer. The BTExplorer window appears.

Figure 3-9    BTExplorer Window

4. Tap and hold Remote Devices and select Discover Devices from the pop-up menu. The mobile computer 
searches for Bluetooth devices in the area.

NOTE When switching between Wizard Mode and Explorer Mode, all active connections are closed. 
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Figure 3-10    Discover Devices

5. The discovered devices display in the Untrusted Devices folder.

Figure 3-11    Discovered Devices Listed in Untrusted Folder

Bonding with Discovered Device(s)

A bond is a relationship created between the mobile computer and another Bluetooth device in order to exchange 
information in a secure manner. Creating a bond involves entering the same PIN on the two devices to bond. Once 
a bond is created, and the Bluetooth radios are turned on, the devices recognize the bond and are able to 
exchange information without re-entering a PIN.

To bond with a discovered Bluetooth device:

1. Discover remote devices. See Discovering Bluetooth Device(s) on page 3-8.

2. In the Untrusted Devices folder, tap and hold on a device to pair with.
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Figure 3-12    Pair a Remote Device

3. Select Pair from the pop-up menu.

4. On the mobile computer, the PIN Code Request window appears.

Figure 3-13    PIN Code Request Window

5. In the PIN Code: text box, enter the PIN number (between 1 and 16 characters) and then tap OK.

6. On the remote device, enter the same PIN number.

7. The devices are successfully paired. The device name moves to the Trusted Devices folder.

Figure 3-14    Bonded (Paired) Discovered Device
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Renaming a Bonded Device

If it is necessary to rename a bonded device, it can be done from the BTExplorer window.

1. Launch BTExplorer.

2. Tap and hold the device to rename and select Rename in the pop-up menu.

Figure 3-15    Rename Device Selection Dialog Box

3. The Change Device Name window appears.

Figure 3-16    Change Device Name Window

4. Enter a new name for the bonded device in the text box. Tap OK.

Deleting a Bonded Device

If it is no longer necessary to connect with a device, delete it from the Bluetooth Bonded Devices window.

1. Launch BTExplorer.

2. Tap and hold the device to delete and.select Delete in the pop-up menu.
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Figure 3-17    Delete a Bonded Device

3. A confirmation dialog appears. Tap Yes.

Accepting a Bond

When a remote device wants to bond with a mobile computer you give permission by entering a PIN when 
requested.

1. Ensure that the mobile computer is set to discoverable and connectable. See Bluetooth Settings on page 3-21.

2. When prompted to bond with the remote device the PIN Code Request window appears.

Figure 3-18    PIN Code Request Window

3. In the PIN Code: text box, enter the same PIN that was entered on the device requesting the bond. The PIN 
must be between 1 and 16 characters.

4. In the Device Name: text box, edit the name of the device requesting the bond, if desired.

5. Tap OK.

6. The bond is created and the mobile computer can now exchange information with the other device.

NOTE Connections to untrusted devices are a security risk.
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Discovering Services
Before services can be used, you must first discover remote devices and then bond to those devices.

To determine what services are available on a bonded remote device:

1. Tap the Bluetooth icon and select Show BTExplorer.

2. In BTExplorer window, tap and hold on the remote device and select Explore from the pop-up menu.

Figure 3-19    Discovering Services

3. The mobile computer communicates with the remote device and then lists the services under the device name.

Figure 3-20    List of Discovered Services

Some examples of available services are:

• File Transfer Services
• Dial-Up Networking Services
• Headset or Hands-Free Services
• OBEX Object Push Services
• Serial Port Services

These services are discussed in the following paragraphs.
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File Transfer Services

To transfer files between the mobile computer and another Bluetooth enabled device:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote access point.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold on the remote device and select Explore from the pop-up menu.

7. Tap and hold on File Transfer and select Connect. The remote device’s accessible folders appear.

8. Select a folder. The contents of the folder appear in the sub-window.

Figure 3-21    Remote Device Folders

9. Tap and hold on the file. A pop-up menu appears.

10. Select the action to perform:

a. New - create a new file or folder. on the remote device

b. Delete - delete the selected file on the remote device.

c. Get File - copy the file from the remote device to the mobile computer.

d. Put File - copies a file from the mobile computer to the remote device.

Create New File or Folder

To create a new folder or file on the remote device:

1. Tap and hold on the file and select New > Folder or New > File. The Create New Folder or Create New File 
window appears.

2. Enter the name for the new folder or file. Tap OK.

3. A new folder or file is created on the remote device.

NOTE Shared folders are a security risk.
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Delete File

To delete a file from the remote device:

1. Tap and hold on the file and select Delete.

2. In the Delete Remote Device File dialog box tap OK.

Get File

To copy a file from a remote device:

1. Tap and hold on the file and select Get. The Save Remote File window appears.

2. Navigate to the directory to save the file.

3. Tap Save. The file is transferred from the remote device to the mobile computer.

Put File

To copy a file to a remote device:

1. Tap and hold on the file and select Put. The Send Local File window appears.

2. Navigate to the directory to save the file and select a file.

3. Tap Open. The file is transferred from the mobile computer to the remote device.

Connect to Internet Using Access Point

This section explains how to access a Bluetooth-enabled LAN access point (AP) for a network connection. With 
this method of communication the Internet Explorer can be used to connect to a server.

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote access point.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold on the remote device and select Explore from the pop-up menu.

7. Tap and hold LAN Access using PPP service and select Connect from the pop-up menu.

8. The mobile computer connects with the Access Point.

9. Tap Start > Internet Explorer. The Internet Explorer window appears.

10. In the address field, enter an internet address and tap the Enter button. The web page loads.

Dial-Up Networking Services

To use a phone that has Bluetooth capabilities as a modem for the mobile computer, create a Bluetooth modem 
connection on the mobile computer and send information to the phone using Bluetooth. The phone relays the 
information over the phone line and sends back to the mobile computer any information that was requested over 
the connection. Once a modem connection is created to the Bluetooth phone, it can be reused.
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Prior to creating a connection, ensure the following:

• Bluetooth phone is turned on.

• Bluetooth phone is discoverable. (Some phones may also need to be pairable in order to accept a bonding 
request. For more information, refer to the phone documentation.)

• Mobile computer’s and phone's Bluetooth radios are turned on.

• Mobile computer and phone are within range of each other (30 feet/10 meters).

Complete the following steps to create a new Bluetooth connection. Before setting up dial-up networking, obtain 
dial-up information and other necessary settings for the office network or ISP.

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote device.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold on Dial-up Networking and select Connect from the pop-up menu. The Select Dial-up Networking 
Entry window appears.

Figure 3-22    Select Dial-up Networking Entry Window

7. Select a dial-up entry.

8. Tap OK. The mobile computer begins to communicate with the phone. If required, the phone requests 
permission to communicate with the mobile computer.

9. Confirm the connection on the phone. The Network Log On window appears.

NOTE If a dial-up entry is not listed, see Add a Dial-up Entry on page 3-17.



Using Bluetooth 3 - 17
Figure 3-23    Network Log On Window

10. In the User name: text box, enter the user name for this connection.

11. In the Password: text box, enter the password for this connection.

12. In the Domain: text box, enter the domain for this connection, if required.

13. Tap OK.

14. The phone begins dialing.

15. The phone connects to the network.

16. To end a session, tap the Connection icon and then tap Disconnect in the dialog box.

Add a Dial-up Entry

To add a dial-up entry:

1. In the Select Dial-up Networking Entry window, tap and hold and then select Add Entry from the pop-up menu.

Figure 3-24    Add Dial-Up Entry

2. The Add Phone Book Entry window appears.
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3. In the Name for the connection text box, enter a name for this connection.

4. In the Country Code text box, enter the country code for the country that you are calling.

5. In the Area Code text box, enter the area code.

6. In the Phone Number text box, enter the phone number.

7. Tap OK.

OBEX Object Push Services

Object Exchange (OBEX) is a set of protocols allowing objects such as pictures to be shared using Bluetooth.

To exchange information with another Bluetooth enabled device:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote device.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.

7. In the Action drop-down list, select one of the options: Send Contact Information, Swap Contact Information, 
Fetch Contact Information or Send a Picture.

Send a Picture

To send a picture to another device:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote device.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.
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Figure 3-25    OBEX Object Push Window

7. In the Action drop-down list, select Send A Picture.

8. Tap . The Send Local Picture window appears.

Figure 3-26    Send Local Picture Window

9. Navigate to the picture that you want to send to the other device.

10. Tap Open.

11. Tap OK. The picture is sent to the other device and a confirmation dialog box appears on the other device to 
accept the picture. A Send Picture dialog appears.

12. Tap Ok.

Headset Services

To connect to a Bluetooth headset:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the headset.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.
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5. Tap the remote device folder.

6. Tap and hold on the remote device and select Explore. A headset service item appears.

7. Tap and hold on the headset service name and select Connect.

8. The mobile computer connects to the headset. Refer to your headset user manual for instruction on 
communicating with a Bluetooth device.

To adjust the microphone gain:

1. Tap and hold on the headset service item and select Adjust Microphone from the pop-up menu. The 
Microphone Properties window appears.

2. Select the slider and adjust the gain.

3. Tap OK.

Serial Port Services

Use the wireless Bluetooth serial port connection just as you would a physical serial cable connection. You must 
configure the application that will use the connection to the correct serial port.

To establish a serial port connection:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote device.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold Serial Port and select Connect in the pop-up menu. The Remote Service Connection window 
appears.

Figure 3-27    Remote Service Connection Window

7. In the Local COM Port drop-down list select a COM port.

8. Tap OK.

NOTE By default, COM ports COM4, COM5 and COM9 are Bluetooth virtual ports. If an application opens one of 
these ports, the Bluetooth driver activates and guides you through a Bluetooth connection.
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Personal Area Network Services

Connect two or more Bluetooth devices to share files, collaborate or play multi player games.

To establish a Personal Area Network connection:

1. Ensure the mobile computer is discoverable and connectable. See Bluetooth Settings on page 3-21.

2. Discover and bond (pair) with the remote device.See Bonding with Discovered Device(s) on page 3-9.

3. In BTExplorer, select the Remote Devices folder.

4. Select the Trusted Devices folder.

5. Tap the remote device folder.

6. Tap and hold Personal Area Network and select Connect in the pop-up menu.

Bluetooth Settings
Use the BTExplorer Settings window to configure the operation of the BTExplorer application. Tap Tools > Settings. 
The BTExplorer Settings window appears.

Device Info Tab

Use the Device Info tab to configure the mobile computer’s Bluetooth connection modes.

Figure 3-28    BTExplorer Settings - Device Info Tab

Device Name Displays the name of the mobile computer.
Discoverable Mode Allows you to set the mobile computer to be discoverable by other Bluetooth devices or not be 

discoverable.
Note: For security reasons, the default is set to Non Discoverable.

Connectable Mode Allows you to set the mobile computer to be connectable by other Bluetooth devices or not be 
connectable.
Note: For security reasons, the default is set to Non Connectable.
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Services Tab

For security reason, by default services are not enabled.

Use the Services tab to add or delete Bluetooth services.

Figure 3-29    BTExplorer Settings - Services Tab

To add a service:

1. Tap Add. The Add Local Service window displays.

Figure 3-30    Add Local Service Window

2. In the list, select a service to add.

3. Tap OK. The Edit Local Service window displays for the selected service.

4. Select the appropriate information and then tap OK. See the following paragraphs for detailed information on 
the available services.

Dial-Up Networking Service

Dial-up Networking allows a dial-up modem to be accessed by other Bluetooth devices.
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Figure 3-31    Add Local Service Window

File Transfer Service

File transfer allows files to be browsed by other Bluetooth devices.

Figure 3-32    File Transfer Information Window

Service Name Displays the name of the service.
Service Security Select the type of security from the drop-down list; None, Authenticate or 

Authenticate/Encrypt.
Local COM Port Select the COM port. Select COM1 to use a modem or other device that is connected to the 

connector on the bottom of the mobile computer.
Local Baud Rate Select the communication baud rate.
Local Port Options Select the port option.

Service Name Displays the name of the service.
Service Security Select the type of security from the drop-down list; None, Authenticate or 

Authenticate/Encrypt.
Root Directory Select the directory that other Bluetooth devices can access.
File Permissions Select the file permissions for the selected directory. Check the appropriate box to 

grant Read access, write access and delete access.
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OBEX Object Push Service

OBEX Object Push allows contacts, business cards, pictures, appointments, and tasks to be pushed to the device 
by other Bluetooth devices.

Figure 3-33    OBEX Exchange Information Window

Personal Area Networking Service

Personal Area Networking hosts a Personal Area Network which allows communication with other Bluetooth 
devices.

Figure 3-34    Personal Area Networking Window

Service Name Displays the name of the service.
Service Security Select the type of security from the drop-down list; None, Authenticate or 

Authenticate/Encrypt.
Do not allow clients to push 
objects

Disables clients from pushing objects to the mobile computer.

Inbox Directory Select a directory where another Bluetooth device can store files.

Service Name Displays the name of the service.
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Serial Port Service

Serial port allows COM ports to be accessed by other Bluetooth devices.

Figure 3-35    Serial Port Service Window

Headset Service

Serial port allows COM ports to be accessed by other Bluetooth devices.

Service Security Select the type of security from the drop-down list; None, Authenticate or 
Authenticate/Encrypt.

Support Group Ad-Hoc 
Networking

Select to enable Ad-Hoc networking.

Service Name Displays the name of the service.
Service Security Select the type of security from the drop-down list; None, Authenticate or 

Authenticate/Encrypt.
Local COM Port Select the COM port. Select COM1 to use a modem or other device that is connected to the 

connector on the bottom of the mobile computer.
Local Baud Rate Select the communication baud rate.
Local Port Options Select the port option.
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Figure 3-36    Headset Service Window

Security Tab

To adjust the security settings for an individual service, select the Services tab first, then select the individual 
service, then Properties.

Figure 3-37    BTExplorer Settings - Security Tab

Discovery Tab

Use the Discovery tab to set and modify discovered devices.

Service Name Displays the name of the service.

Use PIN Code (Incoming 
Connecting)

Select for automatic use of the PIN code entered in the PIN Code text box. It is 
recommended not to use this automatic PIN code feature. See Security on page 3-2 for 
more information.

PIN Code Enter the PIN code.
Encrypt Link On All Outgoing 
Connections

Select to enable or disable encryption. Use encryption whenever possible.
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Figure 3-38    BTExplorer Settings - Discovery Tab

Virtual COM Port Tab

Use the Virtual COM Port tab to select the COM ports for Bluetooth communication.

Figure 3-39    BTExplorer Settings - Virtual COM Port Tab

Inquiry Length Sets the amount of time that the mobile computer takes to discover Bluetooth 
devices in the area.

Name Discovery Mode Select either Automatic or manual.
Discovered Devices Deletes all discovered devices and link keys.

COM4:Bluetooth Enable or disable COM Port 4.
COM5:Bluetooth Enable or disable COM Port 5
COM9:Bluetooth Enable or disable COM Port 9

NOTE If an application uses one of the COM ports assigned to Bluetooth, opening this port causes the Bluetooth 
stack to activate and guide you through the connection process.
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Figure 3-40    COM Port Connection

Miscellaneous Tab

Figure 3-41    BTExplorer Settings - Miscellaneous Tab

Highlight Connections Select the connection type to highlight when connected. In the Wizard Mode, 
the only option is Favorites or None. In the Explorer Mode the options are 
None, Tree View Only, List View Only or Tree and List View.

Apply Text Style Select the text style to be applied to the connection text.
Apply Text Color Select the text color to be applied to the connection text.



Chapter 4 Accessories
Introduction
The MC3000 accessories provide a variety of product support capabilities. Accessories include cradles, cables, 
spare battery chargers and SD cards.

Cradles

• The Single Slot Serial/USB cradle charges the mobile computer main battery and/or a spare battery. It also 
synchronizes the mobile computer with a host computer through either a serial or a USB connection.

• The Four Slot Charge Only cradle charges up to four mobile computers.

• The Four Slot Ethernet cradle charges up to four mobile computers and provides Ethernet communication.

Spare Battery Chargers

• Four Slot Spare Battery Charger charges up to four MC3000 spare batteries.

• UBC Adapter adapts the UBC2000 for use with the MC3000 batteries.

Cables

The cables snap on to the mobile computer and are used to connect external devices to the mobile computer.

• USB client charge cable 

• RS232 Charge cable

• O’Neil printer cable

• Zebra printer cable

• Monarch printer cable.

NOTE The accessory power supply regulatory compliance statements are provided in Table C-1 on page C-1.
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SD Card

The SD card provides additional storage capacity for the mobile computer.

Plastic Holster

The Plastic Holster provides a clip on holder for the mobile computer.

Fabric Holster

The Fabric Holster provides a clip on holder for the mobile computer.

Single Slot Serial/USB Cradle

The Single Slot Serial/USB cradle:

• Provides 5.4VDC power for operating the mobile computer, charging the battery and charging a spare 
battery.

• Provides a serial port and a USB port for data communication between the mobile computer and a host 
computer or other serial devices (e.g., a printer).

• Synchronizes information between the mobile computer and a host computer. With customized or third party 
software, it can also synchronize the mobile computer with corporate databases.

• Provides serial connection through the serial pass-through port for communication with a serial device, such 
as a host computer. For communication setup procedures, refer to the MC3000 Integrator Guide.

• Provides USB connection through the USB pass-through port for communication with a USB device, such as 
a host computer. For communication setup procedures, refer to the MC3000 Integrator Guide.  

Battery Charging

The Single Slot Serial/USB cradle can charge the mobile computer main battery and a spare battery 
simultaneously.

To charge the mobile computer:

1. Slide the mobile computer into the mobile computer slot. The mobile computer amber Charge LED Indicator, 
indicates the mobile computer battery charging status. The Standard Battery charges in less than four hours 
and the Extended Life Battery charges in less than six hours. See Table 4-1 for charging status indications.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.

CAUTION Use only a Symbol approved power supply output rated 12 VDC and minimum 3.3 A. Use of an alternative 
power supply will void the product warranty and may cause product damage. See Appendix C, Regulatory 
for the power supply regulatory compliance statement.
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Figure 4-1    Single Slot Serial/USB Cradle

2. When charging is complete, remove the mobile computer from the mobile computer slot.

To charge the spare battery:

1. Insert the spare battery into the spare battery charging slot, bottom first, and pivot the top of the battery down 
onto the contact pins. 

2. Gently press down on the battery to ensure proper contact. 

3. The Spare Battery Charging LED (see Figure 4-1 on page 4-3) indicates the spare battery charging status. The 
Standard Battery charges in less than four hours and the Extended Life Battery charges in less than six hours. 
See Table 4-1 for charging status indications.

4. When charging is complete, press the battery clip and lift the battery out of the slot.

LED Charge Indications

The Single Slot Serial/USB cradle uses the mobile computer amber Charge LED Indicator to indicate the battery 
charging status and the Spare Battery Charging LED to indicate spare battery charging status. See Table 4-1 for 
charging status indications.

Indicator
LED Bar

Mobile
Computer Slot

Spare Battery

Spare Battery
Charging

LED

Power Port

Serial PortUSB Port

Spare Battery 
Charging Slot

Battery 
ClipCharge LED

Indicator
(amber)
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Table 4-1     LED Charging Status Indicators

LED Indication

Mobile Computer Charging (LED on mobile computer)

Off Mobile computer not placed correctly in the cradle; cable not connected correctly; 
charger is not powered.

Fast Blinking Amber Error in charging; check placement of mobile computer. 

Slow Blinking Amber Mobile computer is charging.

Solid Amber Charging complete.
Note: When the battery is initially inserted in the mobile computer, the amber LED flashes 
once if the battery power is low or the battery is not fully inserted.

Spare Battery Charging (LED on cradle)

Off No spare battery in slot; spare battery not placed correctly; cradle is not powered.

Fast Blinking Amber Error in charging; check placement of spare battery. 

Slow Blinking Amber Spare battery is charging.

Solid Amber Charging complete.
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Four Slot Cradles 

There are two four slot cradles, Four Slot Charge Only cradle and Four Slot Ethernet cradle. The Four Slot 
Ethernet cradle provides Ethernet communications. Both four slot cradles:

• Provide 5.4 VDC power for operating the mobile computer and charging the battery.

• Simultaneously charges up to four mobile computers.

Battery Charging

The four slot cradle can charge up to four mobile computers simultaneously. To charge the mobile computer:

1. Slide the mobile computer into the mobile computer slot. 

Figure 4-2    Four Slot Cradles

2. The mobile computer amber Charge LED Indicator, indicates the mobile computer battery charging status. The 
Standard Battery usually charges in less than four hours and the Extended Life Battery usually charges in less 
than six hours. See Table 4-1 for charging status indications.

3. When charging is complete, remove the mobile computer from the cradle.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.

CAUTION Use only a Symbol approved power supply output rated 12 VDC and minimum 9 A. Use of an alternative 
power supply will void the product warranty and may cause product damage. See Appendix C, Regulatory 
for the power supply regulatory compliance statement.

Scan/Charge Indicator LED Bar 

Mobile Computer Slot 

Charge LED Indicator (amber) 

Speed LED (Ethernet Cradle Only)

Link LED (Ethernet Cradle Only)

Power LED (Charge Only Cradle)
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LED Charge Indications

The Four Slot cradles use the mobile computer amber Charge LED Indicator to indicate the battery charging 
status. See Table 4-1 on page 4-4 for charging status indications. 

Power LED

The green Power LED (only on the Four Slot Charge Only cradle) lights to indicate that the Four Slot Charge Only 
cradle is connected to a power source.

Speed LED

The green Speed LED (only on the Four Slot Ethernet cradle) lights to indicate that the transfer rate is 100 Mbps. 
When it is not lit it indicates that the transfer rate is 10 Mbps.

Link LED

The yellow Link LED (only on the Four Slot Ethernet cradle) blinks to indicate activity, or stays lit to indicate that a 
link is established. When it is not lit, it indicates that there is no link.
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Four Slot Spare Battery Charger 

The Four Slot Spare Battery Charger simultaneously charges up to four spare batteries.

Spare Battery Charging

To charge up to four MC3000 spare batteries:

1. Insert the spare battery into the spare battery charging slot, bottom first.

2. Pivot the top of the battery down onto the contact pins.

Figure 4-3    Four Slot Spare Battery Charger

3. Gently press down on the battery to ensure proper contact. The Standard Battery usually charges in less than 
four hours and the Extended Life Battery usually charges in less than six hours. See Table 4-1 on page 4-4 for 
charging status indications.

4. When charging is complete, press the battery clip and lift battery out of the slot.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.

CAUTION Use only a Symbol approved power supply output rated 12 VDC and minimum 3.3 A. Use of an alternative 
power supply will void the product warranty and may cause product damage. See Appendix C, Regulatory 
for the power supply regulatory compliance statement.

Power Supply

Spare 
Batteries

Spare
Battery

Charging
Slot

Spare Battery
Charging
LEDs (4)

Battery 
Clip

1

2
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LED Charge Indications

The Spare Battery Charging LEDs indicate the spare battery charging status. The Spare Battery Charging LEDs 
are arranged in the same pattern as the spare battery charging slots so that the charging status of each battery can 
be identified. See Table 4-1 on page 4-4 for charging status indications. 

Cables
The cables are available with a variety of connection capabilities.

MC3000 Communication/Charge cables:

• Provide the mobile computer with operating and charging power when used with the Symbol approved power 
supply.

• Synchronize information between the mobile computer and a host computer. With customized or third party 
software, it can also synchronize the mobile computer with corporate databases.

• Provide serial connection through the serial pass-through port for communication with a serial device, such 
as a host computer. For communication setup procedures, refer to the MC3000 Integrator Guide.

• Provide USB connection through the USB pass-through port for communication with a USB device, such as 
a host computer. For communication setup procedures, refer to the MC3000 Integrator Guide. 

The following MC3000 Communication/Charge cables are available:

• Serial (RS232) Charge cable (9-pin D female with power input receptacle)

• USB Client Charge cable (standard-A connector and a barrel receptacle for power). 

Dedicated Printer cables, provide communication with a dedicated printer.

The following printer cables are available directly from the printer manufacturer:

• O’Neil printer cable

• Zebra printer cable

• Monarch printer cable.

CAUTION Use only a Symbol approved power supply output rated 5.4 VDC and minimum 3 A. Use of an alternative 
power supply will void the product warranty and may cause product damage. See Appendix C, Regulatory 
for the power supply regulatory compliance statement.
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Figure 4-4    Cables

Battery Charging and Operating Power 

The MC3000 Communication/Charge cables can charge the mobile computer battery and supply operating power.

To charge the mobile computer battery:

1. Connect the MC3000 Communication/Charge cable power input connector to the Symbol approved power 
source.

2. Slide the bottom of the mobile computer into the MC3000 connector end of the MC3000 
Communication/Charge cable and gently press in until the snaps latch into the mobile computer. 

3. The mobile computer amber Charge LED Indicator indicates the mobile computer battery charging status. The 
Standard Battery usually charges in less than four hours and the Extended Life Battery usually charges in less 
than six hours. See, Table 4-1 on page 4-4 for charging status indications. 

4. When charging is complete, remove the cable by gently pulling the mobile computer and the cable apart until 
the snaps release the mobile computer. 

LED Charge Indications

The MC3000 Communication/Charge cables use the amber Charge LED Indicator to indicate the MC3000 battery 
charging status. See, Table 4-1 on page 4-4 for charging status indications. 

Snaps

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.
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Universal Battery Charger (UBC) Adapter 

The UBC Adapter can be used with a power supply as a standalone spare battery charger or it can be used with 
the four station UBC2000 to simultaneously charge up to four spare batteries. For additional information on the 
UBC 2000, refer to the UBC 2000 Quick Reference Guide p/n 70-33188-xx.

Spare Battery Charging

To charge spare batteries:

1. Insert the spare battery into the spare battery charging slot, bottom first.

2. Pivot the top of the battery down onto the contact pins.

Figure 4-5    UBC Adapter Battery Insertion

3. Gently press down on the battery to ensure proper contact. The Standard Battery usually charges in less than 
four hours and the Extended Life Battery usually charges in less than six hours. See, Table 4-2 on page 4-11 
for charging status indications. 

4. When charging is complete, press the battery clip and lift the battery out of the slot.

UBC Adapter LED Charge Indications

The UBC Adapter charging LEDs indicate the battery charging status. The Standard Battery usually charges in less 
than four hours and the Extended Life Battery usually charges in less than six hours. 

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-1.

CAUTION Use only a Symbol approved power supply output rated 15 VDC and minimum 1.5 A. Use of an alternative 
power supply will void the product warranty and may cause product damage. See Appendix C, Regulatory 
for the power supply regulatory compliance statement.

UBC Adapter

Battery

Battery Clip

Spare Battery 
Charging Slot

2

1
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Figure 4-6    UBC Adapter LEDs

Table 4-2    UBC Adapter Charge LED Status Indications

LED Indication Description

POWER Green Power is connected to the UBC Adapter.

READY or Green Charging complete.

STANDBY 
or

Flashing-Yellow The battery was deeply discharged and is being trickle charged to bring the 
voltage up to the operating level. After operating level voltage is achieved, the 
battery charges normally.

FAULT Yellow Charging error, check placement of mobile computer/spare battery.

CHARGING Yellow Normal charge.

POWER

READY or STANDBY or FAULT

CHARGING

(Green) (Flashing Yellow) (Solid Yellow)

(Solid Yellow)
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Secure Device Card (Windows CE 5.0 Only)
The Secure Device (SD) card provides secondary non-volatile storage (the flash memory is slower than RAM). The 
SD card holder is located under the battery.

To insert the SD card:

1. Remove the battery (see Main Battery Removal on page 1-11).

2. Lift the SD card retaining door.

3. Position the SD card, with the contacts down, into the SD card slot. The SD card corner notch fits into the slot 
only one way.

4. Close SD card retaining door.

Figure 4-7    Inserting the SD Card

5. Replace the battery (see Install Main Battery on page 1-5).

CAUTION Follow proper Electro-Static Discharge (ESD) precautions to avoid damaging the SD card. Proper ESD 
precautions include, but are not limited to, working on an ESD mat and ensuring that the operator is 
properly grounded.

Do not use the SD card slot for any other accessories.

NOTE Select SD cards with environmental and/or the write cycle performance specifications that meet or exceed the 
application requirements.

2GB SD Memory Cards are supported on MC3000 with OEM Version 05.26.0000 and higher.

SD Card Retaining Door SD Card
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Plastic Holster
The Plastic Holster provides a holder for the mobile computer. It consists of a mobile computer holder and a 
detachable belt clip. Press the release button to remove the detachable belt clip.

Figure 4-8    Plastic Holster 

Pinch the clip release and attach the Plastic Holster to a belt or waist band.

Figure 4-9    Attaching the Plastic Holster 

The Plastic Holster holds the mobile computer on a belt or waist band.

To insert the mobile computer, slide the mobile computer into the Plastic Holster with the screen facing the user.

To remove the mobile computer, press and lift to remove the mobile computer.

Detachable Belt Clip

Release Button

Mobile Computer Holder

Clip Release

Mobile Computer Holder
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Figure 4-10    Insert and Remove the Mobile Computer

Insert Mobile Computer Remove Mobile Computer
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Fabric Holster
The Fabric Holster provides a soft holder for the mobile computer. It consists of a fabric mobile computer holder, a 
detachable shoulder strap and a detachable belt clip. Press the release button to remove the detachable belt clip. 
See Figure 4-11 to remove the detachable clip see Figure 4-12 on page 4-15 to attach the Fabric Holster to a belt 
and see Figure 4-13 on page 4-16 to attach the Fabric Holster to a shoulder strap.

Figure 4-11    Fabric Holster Detachable Belt Clip

Belt Clip

Pinch the clip release and attach the Fabric Holster to a belt or waist band.

Figure 4-12    Attaching the Fabric Holster To a Belt

Detachable Belt Clip

Release Button

Mobile Computer Holder

Clip Release

Mobile Computer Holder
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Shoulder Strap

Remove the detachable belt clip (see Figure 4-11 on page 4-15) and attach the shoulder strap.

Figure 4-13    Attach the Fabric Holster To the Shoulder Strap

The Fabric Holster holds the mobile computer on a belt or waist band.

1. To insert the mobile computer, slide the mobile computer into the Fabric Holster with the screen facing the 
user.

2. Pull restraining strap over mobile computer and secure in the clip.

3. To remove the mobile computer, pull down on restraining strap to release from clip and lift retaining strap clear.

4. Lift mobile computer out of Fabric Holster.

Figure 4-14    Insert and Remove the Mobile Computer

Clip Release

Shoulder Strap



Chapter 5 Maintenance and Troubleshooting
Introduction
This chapter includes instructions on cleaning and storing the mobile computer, and provides troubleshooting 
solutions for potential problems during mobile computer operation.

Maintaining the Mobile Computer
For trouble-free service, observe the following tips when using the mobile computer:

• Do not scratch the screen of the mobile computer. When working with the mobile computer, use the supplied 
stylus or plastic-tipped pens intended for use with a touch-sensitive screen. Never use an actual pen or 
pencil or other sharp object on the surface of the mobile computer screen.

• Although the mobile computer is water and dust resistant, do not expose it to rain or moisture for an extended 
period of time. In general, treat the mobile computer as a pocket calculator or other small electronic 
instrument.

• The touch-sensitive screen of the mobile computer is glass. Do not to drop the mobile computer or subject it 
to strong impact. 

• Protect the mobile computer from temperature extremes. Do not leave it on the dashboard of a car on a hot 
day, and keep it away from heat sources.

• Do not store or use the mobile computer in any location that is extremely dusty, damp, or wet.

• Use a soft lens cloth to clean the mobile computer. If the surface of the mobile computer screen becomes 
soiled, clean it with a soft cloth moistened with a diluted window-cleaning solution.

Battery Safety Guidelines
• The area in which the units are charged should be clear of debris and combustible materials or chemicals. 

Particular care should be taken where the device is charged in a non-commercial environment.

• Do not use incompatible batteries and chargers. If you have any questions about the compatibility of a 
battery or a charger, contact Motorola Enterprise Mobility support. See Service Information on page xvi for 
contact information.
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• Do not crush, puncture, or place a high degree of pressure on the battery.

• Severe impact from dropping any battery-operated device on a hard surface could cause the battery to 
overheat.

• Do not leave or store the equipment in or near areas that might get very hot, such as in a parked vehicle or 
near a radiator or other heat source. Do not place battery into a microwave oven or dryer.

• Do not dispose of batteries in fire.

• If you suspect damage to your equipment or battery, contact Motorola Enterprise Mobility support to arrange 
for inspection. See Service Information on page xvi for contact information.

Troubleshooting

Mobile Computer

Table 5-1    Troubleshooting the Mobile Computer

Problem Cause Solution

Mobile computer does 
not turn on.

Main battery not 
charged.

Charge or replace the main battery.

Main battery not 
installed properly.

Ensure the battery is installed properly. See Install Main Battery 
on page 1-5.

System crash. Perform a warm boot. If the mobile computer still does not turn 
on, perform a cold boot. For more information see, Resetting the 
Mobile Computer on page 2-34.

Battery did not charge. Battery failed. Replace battery. If the mobile computer still does not operate, try 
a warm boot, then a cold boot. For more information see, 
Resetting the Mobile Computer on page 2-34.

Mobile computer 
removed from cradle 
while battery was 
charging. 

Insert mobile computer in cradle and begin charging. The 
Standard Battery requires up to four hours to recharge fully and 
the Extended Life Battery requires up to six hours to recharge 
fully.

Extreme battery 
temperature.

Battery does not charge if ambient temperature is below 32°F 
(0°C) or above 104°F (40°C).

Cannot see characters 
on screen.

Mobile computer not 
powered on.

Press the Power button.
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During data 
communication, no data 
was transmitted, or 
transmitted data was 
incomplete.

Mobile computer 
removed from cradle 
or unplugged from 
host computer during 
communication.

Replace the mobile computer in the cradle, or reattach the cable 
and re-transmit.

Incorrect cable 
configuration.

See the system administrator or refer to the MC3000 Integrator 
Guide.

Communication 
software was 
incorrectly installed or 
configured.

See the system administrator or refer to the MC3000 Integrator 
Guide.

Mobile computer does 
not emit sound.

Volume setting is low 
or turned off.

Mobile computer may be a beeper only configuration or incorrect 
setting is programmed into device.

Mobile computer turns 
itself off.

Mobile computer is 
inactive.

The mobile computer turns off after a period of inactivity. This 
period can be set from one to five minutes, in one-minute 
intervals.

Battery is depleted. Recharge or replace the battery.

Battery is not inserted 
properly.

Insert the battery properly. For more information see, Install Main 
Battery on page 1-5.

Tapping the window 
buttons or icons does 
not activate the 
corresponding feature.

Touch screen not 
calibrated correctly.

Re-calibrate the screen. 
From the mobile computer, Demo window double-tap the Ctl 
Panel icon and double-tap on Touch Calibrate. Follow the screen 
prompts.

The system crashed. Warm boot the system. To perform a warm boot, see Resetting 
the Mobile Computer on page 2-34.

A message appears 
stating that the mobile 
computer memory is 
full.

Too many files stored 
on the mobile 
computer.

Delete unused memos and records. If necessary, save these 
records on the host computer.

Too many 
applications installed 
on the mobile 
computer.

Remove unused installed applications from the mobile computer 
to recover memory. 

Table 5-1    Troubleshooting the Mobile Computer (Continued)

Problem Cause Solution
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Single Slot Serial/USB Cradle

The mobile computer 
does not accept scan 
input.

Scanning application 
is not loaded.

Verify that the mobile computer is loaded with a scanning 
application. See the system administrator.

Unreadable bar code. Ensure the symbol is not defaced.

Distance between 
scan window and bar 
code is incorrect.

Ensure the mobile computer is within proper scanning range.

Mobile computer is 
not programmed for 
the bar code type.

Ensure the mobile computer is programmed to accept the type of 
bar code scanned. 

Mobile computer is 
not programmed to 
generate a beep.

If a beep on a good decode is expected and a beep is not heard, 
check that the application is set to generate a beep on good 
decode.

Battery is low. Check the battery level. When the battery is low, the mobile 
computer automatically goes into suspend mode.

Table 5-1    Troubleshooting the Mobile Computer (Continued)

Problem Cause Solution

Table 5-2    Troubleshooting the Single Slot Serial/USB Cradle

Symptom Possible Cause Solution

Mobile computer 
amber Charge LED 
Indicator does not light 
when mobile computer 
inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to both 
the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated.

Spare Battery Charging 
LED does not light 
when spare battery is 
inserted.

Spare battery is not correctly 
seated.

Remove and re-insert the spare battery into the charging 
slot, ensuring it is correctly seated.

Mobile computer 
battery is not charging.

Mobile computer was 
removed from cradle or cradle 
was unplugged from AC 
power too soon.

Ensure cradle is receiving power. Ensure the mobile 
computer is seated correctly. If the mobile computer 
battery is fully depleted, it can take up to four hours to 
fully recharge a Standard Battery and it can take up to six 
hours to fully recharge an Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, replace 
the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 
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Four Slot Charge Only Cradle

Spare battery is not 
charging.

Battery not fully seated in 
charging slot. 

Remove and re-insert the spare battery into the cradle, 
ensuring it is correctly seated.

Battery inserted incorrectly. Ensure the contacts are facing down and toward the 
back of the cradle.

Battery is faulty. Verify that other batteries charge properly. If so, replace 
the faulty battery.

During data 
communication, no 
data was transmitted, 
or transmitted data was 
incomplete.

Mobile computer removed 
from cradle during 
communication.

Replace mobile computer in cradle and retransmit.

Incorrect cable configuration. See the system administrator or refer to the MC3000 
Integrator Guide.

Communication software is 
not installed or configured 
properly.

See the system administrator or refer to the MC3000 
Integrator Guide.

Table 5-2    Troubleshooting the Single Slot Serial/USB Cradle (Continued)

Symptom Possible Cause Solution

Table 5-3    Troubleshooting the Four Slot Charge Only Cradle

Problem Cause Solution

Mobile computer amber 
Charge LED Indicator does 
not light when mobile 
computer inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to 
both the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 

Mobile computer battery is 
not charging.

Mobile computer was 
removed from cradle or cradle 
was unplugged from AC 
power too soon.

Ensure cradle is receiving power. Ensure the 
mobile computer is seated correctly. If the mobile 
computer battery is fully depleted, it can take up to 
four hours to fully recharge a Standard Battery and 
it can take up to six hours to fully recharge an 
Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, 
replace the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 
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Four Slot Ethernet Cradle

Four Slot Spare Battery Charger

Table 5-4    Troubleshooting the Four Slot Ethernet Cradle

Problem Cause Solution

Mobile computer amber 
Charge LED Indicator does 
not light when mobile 
computer inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to 
both the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into 
the cradle, ensuring it is correctly seated. 

Mobile computer battery is 
not charging.

Mobile computer was removed 
from cradle or cradle was 
unplugged from AC power too 
soon.

Ensure cradle is receiving power. Ensure the 
mobile computer is seated correctly. If the mobile 
computer battery is fully depleted, it can take up 
to four hours to fully recharge a Standard Battery 
and it can take up to six hours to fully recharge an 
Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, 
replace the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into 
the cradle, ensuring it is correctly seated. 

During data communication, 
no data was transmitted, or 
transmitted data was 
incomplete.

Mobile computer removed from 
cradle during communication.

Replace mobile computer in cradle and 
retransmit.

Incorrect cable configuration. See the system administrator or refer to the 
MC3000 Integrator Guide.

Ethernet connection error. Link 
LED is not lit (see Link LED on 
page 4-6). 

See the system administrator. Probable Ethernet 
connection error.

Table 5-5    Troubleshooting the Four Slot Spare Battery Charger

Symptom Possible Cause Solution

Spare Battery 
Charging LED does 
not light when 
spare battery is 
inserted.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charging slot, 
ensuring it is correctly seated.
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UBC Adapter

Spare battery is not 
charging.

Charger is not 
receiving power.

Ensure the power cable is connected securely to both the charger 
and to AC power.

Spare battery is not 
correctly seated.

Remove and re-insert the battery into the charger, ensuring it is 
correctly seated. 

Spare battery was 
removed from charger 
or charger was 
unplugged from AC 
power too soon.

Ensure charger is receiving power. Ensure the spare battery is 
seated correctly. If a battery is fully depleted, it can take up to four 
hours to fully recharge a Standard Battery and it can take up to six 
hours to fully recharge an Extended Life Battery.

Spare battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

Table 5-5    Troubleshooting the Four Slot Spare Battery Charger (Continued)

Symptom Possible Cause Solution

Table 5-6    Troubleshooting the UBC Adapter

Symptom Possible Cause Solution

Battery Charging 
LED does not light 
when spare battery 
is inserted.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charging slot, 
ensuring it is correctly seated. 

Battery not charging. Charger is not receiving 
power.

Ensure the power cable is connected securely to both the charger 
and to AC power.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charger, ensuring 
it is correctly seated. 

Spare battery was 
removed from charger 
or charger was 
unplugged from AC 
power too soon.

Ensure charger is receiving power. Ensure the spare battery is 
seated correctly. If a battery is fully depleted, it can take up to four 
hours to fully recharge a Standard Battery and it can take up to six 
hours to fully recharge an Extended Life Battery.

Spare battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.
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Cables

Table 5-7    Troubleshooting the Cables

Symptom Possible Cause Solution

Mobile computer 
amber Charge LED 
Indicator does not 
light when mobile 
computer attached.

Cable is not receiving 
power.

Ensure the power cable is connected securely to both the cable 
and to AC power.

Mobile computer is not 
seated correctly in the 
cable.

Remove and re-attach the mobile computer to the MC3000 
connector, ensuring it is correctly seated. 

Mobile computer 
battery is not 
charging.

Mobile computer was 
detached from cable or 
cable was unplugged 
from AC power too 
soon.

Ensure cable is receiving power. Ensure the mobile computer is 
seated correctly. If the mobile computer battery is fully depleted, it 
can take up to four hours to fully recharge a Standard Battery and 
it can take up to six hours to fully recharge an Extended Life 
Battery.

Battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

The mobile computer is 
not fully seated in the 
cable.

Remove and re-attach the mobile computer to the cable, ensuring 
it is correctly seated. 

During data 
communication, no 
data was 
transmitted, or 
transmitted data was 
incomplete.

Cable removed from 
mobile computer during 
communication.

Reattach cable to mobile computer and retransmit.

Incorrect cable 
configuration.

See the system administrator or refer to the MC3000 Integrator 
Guide.

Communication 
software is not installed 
or configured properly.

See the system administrator or refer to the MC3000 Integrator 
Guide.



Appendix A  Technical Specifications
Mobile Computer and Accessory Technical Specifications
Table A-1 summarizes the mobile computer technical specifications and intended operating environments. 

Table A-2 summarizes the accessory technical specifications and the intended operating environments.

Table A-1    Mobile Computer Technical Specifications

Item Description

Operating Temperature Color
14° to 122°F (-10° to +50°C)
Monochrome
-4° to 122°F (-20° to +50°C)

Storage Temperature -22° to 158°F (-30° to 70°C)

Battery Charging 
Temperature 

32° to 104° F (0° to +40° C) ambient temperature

Humidity 5% to 95% non-condensing

Electrostatic Discharge (ESD) +/-15 kV air discharge 
+/- 8 kV direct discharge 
+/- 8 kV indirect discharge 

Sealing IP54 category 2

Drop Multiple 4-foot (1.2 m) drops to concrete across operating temperature

Tumble 500 one-half meter tumbles at room temperature (1000 drops)
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Dimensions MC3000S:
7.43 in L x 3.18 in W x 1.76 in D
(188.7 mm L x 80.8 mm W x 44.6 mm D)

MC3000R:
8.33 in L x 3.18 in W x 1.57 in D
(211.6 mm L x 80.8 mm W x 39.9 mm D)

MC3090G:
7.60 in L x 3.18 in W x 6.54 in D
(193 mm L x 80.8 mm W x 166 mm H)

Weights MC3000R (with standard battery)* - 12.9 oz (366 g)
MC3000S (with extended battery)* - 14.6 oz (414 g)
MC3090G (with extended battery)* - 18.6 oz (527 g)

*For WLAN mobile computers add approximately 0.5 oz (14 g).

Display Transflective color TFT-LCD, 65K colors, 324 x 324 
Monochrome FSTN, 16 shades, 320 x 320

Touch Panel Glass, analog resistive touch

Main Battery Standard: Rechargeable Lithium-Polymer 2600 mAh minimum (3.7V)
Extended Life: Rechargeable Lithium-Ion 4400 mAh minimum (3.7V)

Backup Battery Ni-MH battery (rechargeable), 20mAh (3.6V) 3 cells

Operating Platform Microsoft® Windows CE .NET 5.0 Professional

Microsoft® Windows CE .NET 5.0 Core

Microsoft® Windows Mobile 6.1 Classic

Processor/Memory Intel® XScale™ PXA270 312 MHz with 32 MB RAM/64 MB Flash or

Intel® XScale™ PXA270 520 MHz with 64 MB RAM/64 MB Flash or

Intel® XScale™ PXA270 520 MHz with 128 MB RAM/64 MB Flash or

Intel® XScale™ PXA270 520 MHz with 128 MB RAM/64 MB Flash + 1GB Flash 
storage

Interface RS232 (115.2 kbps max), USB and Bluetooth

WLAN  802.11a/b/g

Keypad Options 20-key mechanical, 28-key, 38-key and 48-key.

Table A-1    Mobile Computer Technical Specifications (Continued)

Item Description
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Data Capture:
Code 39, code 128, code 93, codabar, code 11, discrete 2 of 5, EAN-3, EAN-13, 
EAN-128, interleaved 2 of 5, UPCA, UPCE and UPC/EAN supplements, chinese 2 
of 5 (OEM version 05.26.000 and higher).

1-D Decode Capability*

Imaging Decode 
Capability*

Code 39, code 128, code 93, codabar, code 11, discrete 2 of 5, EAN-3, EAN-13, 
EAN-128, interleaved 2 of 5, TLC39 (telecommunications, UPCA, UPCE, UPC/EAN 
supplements composite code (retail), coupon code (retail), macro PDF-417, 
(macro) micro PDF-417 (T&L), micro PDF-417 (telecommunications), MSI Plessey, 
PDF-417 (automotive), RSS expanded, RSS limited and RSS-14Maxi Code (UPS), 
Data matrix (electronics industry, US Planet (USPS), UK 4-state, Australian 4-state, 
Canadian 4-state, Japanese 4-state, Dutch Kix
Aztec, USPS 4-state(US4CB) and microQR (OEM version 05.26.000 and higher).

*Go to http://software.symbol.com/ for a list of the latest supported symbologies.

SD cards
(Windows CE 5.0 only) Select SD cards with environmental and/or the write cycle performance 

specifications that meet or exceed the application requirements. 

Table A-2    Accessory Specifications

Single Slot 
Serial/USB 

Cradle
Cables

Four Slot Charge 
Only and 

Ethernet Cradles

Four Slot 
Spare Battery 

Charger

Universal 
Battery Charger 
(UBC) Adapter

Operating 
Temperature

32° to 122°F (0° to +50°C) 32° to 104°F (0° to +40°C)

Storage Temperature -40° to 158°F (-40° to 70°C)

Battery Charging 
Temperature

32° to 104° F (0° to +40° C) ambient temperature

Humidity 5% to 95% non-condensing

Size (L x D x H) 4.4 in x 5.7 in x 4.7 
in
(11.2 cm x 14.5 cm 
x 12 cm)

6 feet
(1.83 
m)

18 in x 4 in x 5 in
(45.7 cm x 10.1 cm 
x 12 cm)

8.25 in x 6.0 in 
x 1.7 in (20.96 
cm x 15.24 cm 
x 4.32 cm)

2.5 in x 6.1 in x 1.5 
in
(6.4 cm x 15.5 cm 
x 3.8 cm)

Weight 0.60 lbs (0.27 kg) N/A Charge only:
2.25 lbs (1.02 kg)
Ethernet:
2.38 lbs (1.08 kg)

13.6 oz (386 g) 0.25 lbs (0.11 kg)

Table A-1    Mobile Computer Technical Specifications (Continued)

Item Description
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Power 12V, 3.3 A 5.4V, 3 
A

12V, 9 A 12V, 3.3 A 15V, 1.5 A

Drop 30 inches (76.2 centimeter) to vinyl covered concrete

Electrostatic 
Discharge (ESD)

+/-15 kV air discharge, +/- 8 kV direct discharge, +/- 8 kV indirect discharge 

Table A-2    Accessory Specifications (Continued)

Single Slot 
Serial/USB 

Cradle
Cables

Four Slot Charge 
Only and 

Ethernet Cradles

Four Slot 
Spare Battery 

Charger

Universal 
Battery Charger 
(UBC) Adapter



Appendix B Keypad Functions/Special 
Characters
Introduction
This appendix contains the keypad functions/special characters for the MC3000 keypads. Each function/special 
character is included in the table along with how the function/special character is generated. 

Keypads
The mobile computer is available with one of four keypads:

• 20-key keypad

• 28-key keypad

• 38-key keypad 

• 48-key keypad.

The keypads can be selected as necessary to support specialized applications. The 28, 38 and 48-key keypads 
contain a Power button, application keys, scroll keys and function keys. The keypads are color-coded to indicate 
the alternate function key (blue) values and the alternate ALPHA key (orange) values. See Table B-1 for the 
special character generation. Characters can also be generated using the keyboard input panel. For more 
information see, Entering Information Using the Keyboard Input Panel on page 2-25.

NOTE Special characters are not available on the 20-key keypad.
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Figure B-1    Keypads

Table B-1    Special Character Generation Map 

Special 
Character

28-Key Keypad Key 
Sequence, Special 

Character Generation

38-Key Keypad Key 
Sequence, Special 

Character Generation

48-Key Keypad Key 
Sequence, Special 

Character Generation

[ Use the Keyboard Input 
Panel*

FUNC + 4 FUNC + T

] Use the Keyboard Input 
Panel*

FUNC + 5 FUNC + U

/ Use the Keyboard Input 
Panel*

FUNC + 9 FUNC + Q

\ Use the Keyboard Input 
Panel*

FUNC + 3 Use the Keyboard Input 
Panel*

= Use the Keyboard Input 
Panel*

FUNC + 8 FUNC + P

* See Entering Information Using the Keyboard Input Panel on page 2-25.

28-Key Keypad 48-Key Keypad38-Key Keypad
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; Use the Keyboard Input 
Panel*

FUNC + 6 FUNC + V

- Use the Keyboard Input 
Panel*

FUNC + 7 FUNC + O

` Use the Keyboard Input 
Panel*

FUNC + 2 FUNC + Y

“ Use the Keyboard Input 
Panel*

SHIFT + FUNC + 1 Use the Keyboard Input 
Panel*

! SHIFT + 1 SHIFT + 1 SHIFT + 1

@ SHIFT + 2 SHIFT + 2 SHIFT + 2

# SHIFT + 3 SHIFT + 3 SHIFT + 3

$ SHIFT + 4 SHIFT + 4 SHIFT + 4

% SHIFT + 5 SHIFT + 5 SHIFT + 5

^ SHIFT + 6 SHIFT + 6 SHIFT + 6

& SHIFT + 7 SHIFT + 7 SHIFT + 7

* SHIFT + 8 SHIFT + 8 SHIFT + 8

( SHIFT + 9 SHIFT + 9 or FUNC + SHIFT 
+ 9

SHIFT + 9

) SHIFT + 0 SHIFT + 0 or FUNC + SHIFT 
+ 0

SHIFT + 0

‘ Use the Keyboard Input 
Panel*

FUNC + 1 FUNC + X

“ Use the Keyboard Input 
Panel*

Use the Keyboard Input 
Panel*

Use the Keyboard Input 
Panel*

+ Use the Keyboard Input 
Panel*

SHIFT + FUNC + 8 Use the Keyboard Input 
Panel*

: Use the Keyboard Input 
Panel*

SHIFT + FUNC + 6 Use the Keyboard Input 
Panel*

< Use the Keyboard Input 
Panel*

FUNC + SHIFT + , Use the Keyboard Input 
Panel*

> Use the Keyboard Input 
Panel*

FUNC + SHIFT + . SHIFT + .

Table B-1    Special Character Generation Map  (Continued)

Special 
Character

28-Key Keypad Key 
Sequence, Special 

Character Generation

38-Key Keypad Key 
Sequence, Special 

Character Generation

48-Key Keypad Key 
Sequence, Special 

Character Generation

* See Entering Information Using the Keyboard Input Panel on page 2-25.
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? Use the Keyboard Input 
Panel*

SHIFT + FUNC + 9 Use the Keyboard Input 
Panel*

_ Use the Keyboard Input 
Panel*

SHIFT + FUNC + 7 Use the Keyboard Input 
Panel*

{ Use the Keyboard Input 
Panel*

SHIFT + FUNC + 4 Use the Keyboard Input 
Panel*

} Use the Keyboard Input 
Panel*

SHIFT + FUNC + 5 Use the Keyboard Input 
Panel*

~ Use the Keyboard Input 
Panel*

SHIFT + FUNC + 2 Use the Keyboard Input 
Panel*

| N/A SHIFT + FUNC + 3 N/A

Table B-1    Special Character Generation Map  (Continued)

Special 
Character

28-Key Keypad Key 
Sequence, Special 

Character Generation

38-Key Keypad Key 
Sequence, Special 

Character Generation

48-Key Keypad Key 
Sequence, Special 

Character Generation

* See Entering Information Using the Keyboard Input Panel on page 2-25.



Appendix C Regulatory
Introduction
This appendix contains the accessory power supply regulatory compliance statements.

Accessory Power Supply Regulatory Compliance

Table C-1    Accessory Power Supplies, Regulatory Compliance Statements

Accessory Power Supplies Regulatory Compliance Statements

Single Slot Serial/USB Cradle 
Power Supply

Use only a Symbol-approved power supply output rated 12 VDC and minimum 3.3 
A. The power supply is certified to EN60950 with SELV outputs. Use of alternative 
power supply will invalidate any approval given to this device and may be 
dangerous.

Hinweis: Benutzen Sie nur eine von Symbol Technologies genehmigte 
Stromversorgung mit einer Ausgangsleistung von 12 V (Gleichstrom) und 
mindestens 3.3 A. Die Stromversorgung ist nach EN60950 für die Verwendung in 
SELV-Stromkreisen zertifiziert. Bei Verwendung eines anderen Netzteils werden 
alle für das Gerät gewährten Genehmigungen außer Kraft gesetzt, und der 
Betrieb kann gefährlich sein.

Four Slot Spare Battery 
Charger Power Supply
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Four Slot Charge Only Cradle 
Power Supply

Use only a Symbol-approved power supply output rated 12 VDC and minimum 9 
A. The power supply is certified to EN60950 with SELV outputs. Use of alternative 
power supply will invalidate any approval given to this device and may be 
dangerous.

Hinweis: Benutzen Sie nur eine von Symbol Technologies genehmigte 
Stromversorgung mit einer Ausgangsleistung von 12 V (Gleichstrom) und 
mindestens 9 A. Die Stromversorgung ist nach EN60950 für die Verwendung in 
SELV-Stromkreisen zertifiziert. Bei Verwendung eines anderen Netzteils werden 
alle für das Gerät gewährten Genehmigungen außer Kraft gesetzt, und der 
Betrieb kann gefährlich sein.

Four Slot Ethernet Cradle 
Power Supply

Universal Battery Charger 
(UBC) Adapter Power Supply

Use only a Symbol-approved power supply output rated 15 VDC and minimum 1.5 
A. The power supply is certified to EN60950 with SELV outputs. Use of alternative 
power supply will invalidate any approval given to this device and may be 
dangerous.

Hinweis: Benutzen Sie nur eine von Symbol Technologies genehmigte 
Stromversorgung mit einer Ausgangsleistung von 15 V (Gleichstrom) und 
mindestens 1.5 A. Die Stromversorgung ist nach EN60950 für die Verwendung in 
SELV-Stromkreisen zertifiziert. Bei Verwendung eines anderen Netzteils werden 
alle für das Gerät gewährten Genehmigungen außer Kraft gesetzt, und der 
Betrieb kann gefährlich sein.

Charging Cables Power 
Supply

Use only a Symbol-approved power supply output rated 5.4 VDC and minimum 3 
A. The power supply is certified to EN60950 with SELV outputs. Use of alternative 
power supply will invalidate any approval given to this device and may be 
dangerous.

Hinweis: Benutzen Sie nur eine von Symbol Technologies genehmigte 
Stromversorgung mit einer Ausgangsleistung von 5.4 V (Gleichstrom) und 
mindestens 3 A. Die Stromversorgung ist nach EN60950 für die Verwendung in 
SELV-Stromkreisen zertifiziert. Bei Verwendung eines anderen Netzteils werden 
alle für das Gerät gewährten Genehmigungen außer Kraft gesetzt, und der 
Betrieb kann gefährlich sein.

Table C-1    Accessory Power Supplies, Regulatory Compliance Statements

Accessory Power Supplies Regulatory Compliance Statements
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Numeric
802.11/802.11abg. A radio protocol that may be used by the WLAN radio card.

A
Access Point. Access Point (AP) refers to Motorola’s Ethernet Access Point. It is a piece of communications equipment that 

manages communications between the host computer system and one or more wireless terminals. An AP connects to 
a wired Ethernet LAN and acts as a bridge between the Ethernet wired network and IEEE 802.11 interoperable 
radio-equipped mobile units, such as a mobile computer. The AP allows a mobile user to roam freely through a facility 
while maintaining a seamless connection to the wired network.

AirBEAM® Manager. AirBEAM® Manager is a comprehensive wireless network management system that provides 
essential functions that are required to configure, monitor, upgrade and troubleshoot the   wireless network and its 
components (including networked mobile computers). Some features include event notification, access point 
configuration, diagnostics, statistical reports, auto-discovery, wireless proxy agents and monitoring of access points and 
mobile units. 

AirBEAM® Smart Client. AirBEAM® Smart Client is part of Motorola’s AirBEAM® suite, which also includes AirBEAM® 
Safe and AirBEAM® Manager. The AirBEAM® Smart Client system uses the network accessible host server to store 
software files that are to be downloaded to the mobile computers. The AirBEAM® Smart Client provides the mobile 
computers with the “smarts” to request software from the host. It allows them to request, download and install software, 
as well as to upload files and status data. The AirBEAM® Smart Client uses the industry standard FTP or TFTP file 
transfer protocols to check the host system for updates, and if necessary, to transfer updated software. Most often, 
AirBEAM® Smart Client is used with wireless networks, but any TCP/IP connection can be used. For more information, 
refer to the AirBEAM® Smart Windows® CE Client Product Reference Guide (p/n 72-63060-xx).

AP. See Access Point.

Aperture. The opening in an optical system defined by a lens or baffle that establishes the field of view.

 ASCII. American Standard Code for Information Interchange. A 7 bit-plus-parity code representing 128 letters, numerals, 
punctuation marks and control characters. It is a standard data transmission code in the U.S.
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B
Bar. The dark element in a printed bar code symbol.

Bar Code. A pattern of variable-width bars and spaces which represents numeric or alphanumeric data in machine-readable 
form. The general format of a bar code symbol consists of a leading margin, start character, data or message character, 
check character (if any), stop character, and trailing margin. Within this framework, each recognizable symbology uses 
its own unique format. See Symbology.

Bar Code Density. The number of characters represented per unit of measurement (e.g., characters per inch).

Bar Height. The dimension of a bar measured perpendicular to the bar width.

Bar Width. Thickness of a bar measured from the edge closest to the symbol start character to the trailing edge of the same 
bar.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of data. 
The pattern of 0 and 1 values within the byte determines its meaning.

Bits per Second (bps). Bits transmitted or received.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of data. 
The pattern of 0 and 1 values within the byte determines its meaning.

bps.  See Bits Per Second.

Byte. On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to represent a specific 
character or numeric value. Bits are numbered from the right, 0 through 7, with bit 0 the low-order bit. One byte in 
memory is used to store one ASCII character.

boot or boot-up. The process a computer goes through when it starts. During boot-up, the computer can run self-diagnostic 
tests and configure hardware and software.

C
CDRH. Center for Devices and Radiological Health. A federal agency responsible for regulating laser product safety. This 

agency specifies various laser operation classes based on power output during operation.

CDRH Class 1. This is the lowest power CDRH laser classification. This class is considered intrinsically safe, even if all laser 
output were directed into the eye's pupil. There are no special operating procedures for this class.

CDRH Class 2. No additional software mechanisms are needed to conform to this limit. Laser operation in this class poses 
no danger for unintentional direct human exposure.

Character. A pattern of bars and spaces which either directly represents data or indicates a control function, such as a 
number, letter, punctuation mark, or communications control contained in a message.

Character Set. Those characters available for encoding in a particular bar code symbology.
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Check Digit. A digit used to verify a correct symbol decode. The scanner inserts the decoded data into an arithmetic formula 
and checks that the resulting number matches the encoded check digit. Check digits are required for UPC but are 
optional for other symbologies. Using check digits decreases the chance of substitution errors when a symbol is 
decoded.

Codabar. A discrete self-checking code with a character set consisting of digits 0 to 9 and six additional characters: (“-”, “$”, 
“:”, “/”, “,”, and “+”).

Code 128. A high density symbology which allows the controller to encode all 128 ASCII characters without adding extra 
symbol elements.

Code 3 of 9 (Code 39). A versatile and widely used alphanumeric bar code symbology with a set of 43 character types, 
including all uppercase letters, numerals from 0 to 9 and 7 special characters (“-”, “.”, “/”, “+”, “%”, “$” and space). The 
code name is derived from the fact that 3 of 9 elements representing a character are wide, while the remaining 6 are 
narrow.

Code 93. An industrial symbology compatible with Code 39 but offering a full character ASCII set and a higher coding 
density than Code 39.

Code Length. Number of data characters in a bar code between the start and stop characters, not including those 
characters.

Cold Boot. A cold boot restarts the mobile computer and erases all user stored records and entries.

COM port.  Communication port; ports are identified by number, e.g., COM1, COM2.

Continuous Code. A bar code or symbol in which all spaces within the symbol are parts of characters. There are no 
intercharacter gaps in a continuous code. The absence of gaps allows for greater information density.

Cradle. A cradle is used for charging the terminal battery and for communicating with a host computer, and provides a 
storage place for the terminal when not in use.

D
Dead Zone. An area within a scanner's field of view, in which specular reflection may prevent a successful decode.

Decode. To recognize a bar code symbology (e.g., UPC/EAN) and then analyze the content of the specific bar code 
scanned.

Decode Algorithm. A decoding scheme that converts pulse widths into data representation of the letters or numbers 
encoded within a bar code symbol.

Decryption. Decryption is the decoding and unscrambling of received encrypted data. Also see, Encryption and Key.

Depth of Field. The range between minimum and maximum distances at which a scanner can read a symbol with a certain 
minimum element width.

Discrete Code. A bar code or symbol in which the spaces between characters (intercharacter gaps) are not part of the code.
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Discrete 2 of 5. A binary bar code symbology representing each character by a group of five bars, two of which are wide. 
The location of wide bars in the group determines which character is encoded; spaces are insignificant. Only numeric 
characters (0 to 9) and START/STOP characters may be encoded.

E
EAN. European Article Number. This European/International version of the UPC provides its own coding format and 

symbology standards. Element dimensions are specified metrically. EAN is used primarily in retail.

Element. Generic term for a bar or space.

EMDK. Enterprise Mobility Developer’s Kit.

Encoded Area. Total linear dimension occupied by all characters of a code pattern, including start/stop characters and data.

ESD. Electro-Static Discharge

ESN. Electronic Serial Number. The unique hardware number associated with a cellular device, which is transmitted to the 
system when the device communicates with the cellular system.

Ethernet. Ethernet communication port. Allows a wired interface to a radio network.

F
Flash Memory. Flash memory is nonvolatile, semi-permanent storage that can be electronically erased in the circuit and 

reprogrammed. Mobile computers may use Flash memory to store the operating system (ROM-DOS), the terminal 
emulators, and the Citrix ICA Client for DOS. 

FTP. See File Transfer Protocol.

Flash Memory. Flash memory is responsible for storing the system firmware and is non-volatile. If the system power is 
interrupted the data is not be lost.

G
Gateway Address. An IP address for a network gateway or router. A mobile computer may be part of a subnet as specified 

by its IP address and Netmask. It can send packets directly to any node on the same subnet. If the destination node is 
on a different subnet, then the terminal sends the packet to the gateway first. The gateway determines how to route the 
packet to the destination subnet. This field is an option used by networks that require gateways.

H
Hard Reset. See Cold Boot.
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Hz. Hertz; A unit of frequency equal to one cycle per second.

Host Computer. A computer that serves other terminals in a network, providing such services as computation, database 
access, supervisory programs and network control.

I
IEC. International Electrotechnical Commission. This international agency regulates laser safety by specifying various laser 

operation classes based on power output during operation.

IEC (825) Class 1. This is the lowest power IEC laser classification. Conformity is ensured through a software restriction of 
120 seconds of laser operation within any 1000 second window and an automatic laser shutdown if the scanner's 
oscillating mirror fails. 

Interleaved 2 of 5. A binary bar code symbology representing character pairs in groups of five bars and five interleaved 
spaces. Interleaving provides for greater information density. The location of wide elements (bar/spaces) within each 
group determines  which  characters  are encoded. This continuous code type uses no intercharacter spaces. Only 
numeric (0 to 9) and START/STOP characters may be encoded.

imaging scanning . Mobile computers with an integrated imager use digital camera technology to take a digital picture of 
a bar code, store the resulting image in memory and execute state-of-the-art software decoding algorithms to extract 
the data from the image.

Intercharacter Gap.  The space between two adjacent bar code characters in a discrete code.

Interleaved Bar Code. A bar code in which characters are paired together, using bars to represent the first character and 
the intervening spaces to represent the second.

Interleaved 2 of 5. A binary bar code symbology representing character pairs in groups of five bars and five interleaved 
spaces. Interleaving provides for greater information density. The location of wide elements (bar/spaces) within each 
group determines which characters are encoded. This continuous code type uses no intercharacter spaces. Only 
numeric (0 to 9) and START/STOP characters may be encoded.

IP. Internet Protocol. The IP part of the TCP/IP communications protocol. IP implements the network layer (layer 3) of the 
protocol, which contains a network address and is used to route a message to a different network or subnetwork. IP 
accepts “packets” from the layer 4 transport protocol (TCP or UDP), adds its own header to it and delivers a “datagram” 
to the layer 2 data link protocol. It may also break the packet into fragments to support the maximum transmission unit 
(MTU) of the network.

IP Address. (Internet Protocol address) The address of a computer attached to an IP network. Every client and server 
station must have a unique IP address. A 32-bit address used by a computer on a IP network. Client workstations have 
either a permanent address or one that is dynamically assigned to them each session. IP addresses are written as four 
sets of numbers separated by periods; for example, 204.171.64.2.

L
LAN. Local area network. A radio network that supports data communication within a local area, such as within a warehouse 

of building.
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laser scanner. A type of bar code reader that uses a beam of laser light.

LASER.  Light Amplification by Stimulated Emission of Radiation.The laser is an intense light source. Light from a laser is 
all the same frequency, unlike the output of an incandescent bulb. Laser light is typically coherent and has a high energy 
density.

Laser Diode. A gallium-arsenide semiconductor type of laser connected to a power source to generate a laser beam. This 
laser type is a compact source of coherent light.

LED Indicator. A semiconductor diode (LED - Light Emitting Diode) used as an indicator, often in digital displays. The 
semiconductor uses applied voltage to produce light of a certain frequency determined by the semiconductor's particular 
chemical composition.

Light Emitting Diode. See LED.

M
MC. Mobile Computer.

MIL. 1 mil = 1 thousandth of an inch.

MIN. Mobile Identification Number. The unique account number associated with a cellular device. It is broadcast by the 
cellular device when accessing the cellular system.

Misread (Misdecode). A condition which occurs when the data output of a reader or interface controller does not agree with 
the data encoded within a bar code symbol.

Mobile Computer. In this text, mobile computer refers to the Symbol portable computer. It can be set up to run as a 
stand-alone device, or it can be set up to communicate with a network, using wireless radio technology.

N
Nominal. The exact (or ideal) intended value for a specified parameter. Tolerances are specified as positive and negative 

deviations from this value.

Nominal Size. Standard size for a bar code symbol. Most UPC/EAN codes are used over a range of magnifications (e.g., 
from 0.80 to 2.00 of nominal).

NVM. Non-Volatile Memory.

P
Parameter. A variable that can have different values assigned to it.

PDT. Portable Data Terminal.
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Percent Decode. The average probability that a single scan of a bar code would result in a successful decode. In a 
well-designed bar code scanning system, that probability should approach near 100%.

Q
Quiet Zone. A clear space, containing no dark marks, which precedes the start character of a bar code symbol and follows 

the stop character.

R
RAM. Random Access Memory. Data in RAM can be accessed in random order, and quickly written and read.

Reflectance. Amount of light returned from an illuminated surface.

Resolution. The narrowest element dimension which is distinguished by a particular reading device or printed with a 
particular device or method.

RF. Radio Frequency.

ROM. Read-Only Memory. Data stored in ROM cannot be changed or removed.

Router. A device that connects networks and supports the required protocols for packet filtering. Routers are typically used 
to extend the range of cabling and to organize the topology of a network into subnets. See Subnet.

RS232. An Electronic Industries Association (EIA) standard that defines the connector, connector pins, and signals used to 
transfer data serially from one device to another.

S
Scan Area. Area intended to contain a symbol.

Scanner. An electronic device used to scan bar code symbols and produce a digitized pattern that corresponds to the bars 
and spaces of the symbol. Its three main components are:

1. Light source (laser or photoelectric cell) - illuminates a bar code.

2. Photodetector - registers the difference in reflected light (more light reflected from spaces).

3. Signal conditioning circuit - transforms optical detector output into a digitized bar pattern.

Scanning Mode. The scanner is energized, programmed and ready to read a bar code.

Scanning Sequence. A method of programming or configuring parameters for a bar code reading system by scanning bar 
code menus.

SDK. Software Development Kit
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Self-Checking Code. A symbology that uses a checking algorithm to detect encoding errors within the characters of a bar 
code symbol.

Shared Key. Shared Key authentication is an algorithm where both the AP and the MU share an authentication key.

SID. System Identification code. An identifier issued by the FCC for each market. It is also broadcast by the cellular carriers 
to allow cellular devices to distinguish between the home and roaming service.

Soft Reset. See Warm Boot.

Space. The lighter element of a bar code formed by the background between bars.

Specular Reflection. The mirror-like direct reflection of light from a surface, which can cause difficulty decoding a bar code.

Spring Radio Protocol. A radio protocol that may be used by the Symbol radio card. Symbol Radio cards that use the 
Spring protocol also have an Net ID.

Start/Stop Character. A pattern of bars and spaces that provides the scanner with start and stop reading instructions and 
scanning direction. The start and stop characters are normally to the left and right margins of a horizontal code.

Subnet. A subset of nodes on a network that are serviced by the same router. See Router.

Subnet Mask. A 32-bit number used to separate the network and host sections of an IP address. A custom subnet mask 
subdivides an IP network into smaller subsections. The mask is a binary pattern that is matched up with the IP address 
to turn part of the host ID address field into a field for subnets. Default is often 255.255.255.0.

Substrate. A foundation material on which a substance or image is placed.

SVTP. Symbol Virtual Terminal Program.

Symbol. A scannable unit that encodes data within the conventions of a certain symbology, usually including start/stop 
characters, quiet zones, data characters and check characters.

Symbol Aspect Ratio. The ratio of symbol height to symbol width.

Symbol Height. The distance between the outside edges of the quiet zones of the first row and the last row.

Symbol Length. Length of symbol measured from the beginning of the quiet zone (margin) adjacent to the start character 
to the end of the quiet zone (margin) adjacent to a stop character.

Symbology. The structural rules and conventions for representing data within a particular bar code type (e.g. UPC/EAN, 
Code 39, PDF417, etc.).

T
Tolerance. Allowable deviation from the nominal bar or space width.
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U
UPC. Universal Product Code. A relatively complex numeric symbology. Each character consists of two bars and two 

spaces, each of which is any of four widths. The standard symbology for retail food packages in the United States.

V
Visible Laser Diode (VLD). A solid state device which produces visible laser light.

W
WAN. Wide-Area Network. A radio network that supports data communication beyond a local area. That is, information can 

be sent across a city, state, or even nationwide.

Warm Boot. A warm boot restarts the mobile computer by closing all running programs. All data that is not saved to flash 
memory is lost.

Wireless Local Area Network (WLAN). See LAN.

Wireless Wide Area Network (WWAN). See WAN.

WNMP. (Wireless Network Management Protocol) This is Symbol’s proprietary MAC layer protocol used for inter access 
point communication and other MAC layer communication.
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